
 



Preface

While working on a 3D groundwater modeling project in the early 1990s, I wished to
visualize the model results in a more clear way than a bunch of tangling flowlines and
contour lines plotted on graph paper. At that time, personal computers were just in their
infancy and my coding skill and knowledge were limited. Resources for learning bet-
ter coding practices were scant simply because Internet was not available at that time.
Nevertheless, attempts have been made to applications using Microsoft QuickBasic to
display model results in three dimensions. The display of 3D flowlines was relatively
straightforward; however, it was simply impractical to write codes in the BASIC lan-
guage to display 3D plumes, contour slices, and digital elevation models with terrain
textures.

With the advance of the computing power, we are surrounded by ever-growing
amount of datasets that need to be analyzed or visualized. While some datasets can
be represented by printed charts or maps, presentation of three-dimensional geometric
objects with multivariable data sets on paper is often very difficult to understand. Hence,
multiple cross-sectional slices are often used to assemble a 3D scene, despite of the fact
that understanding the connections between the individual slices and fluid dynamics is
still a difficult task. Seer3D is written to solve a part of the problems with the capability
to visualize data transiting seamlessly from field measurements to model predictions.
Using the state-of-the-art programming techniques, Seer3D presents complex datasets
in crystal clear 3D display and stereographic rendering capabilities that are far superior
to slices or spoken words. It can effectively enable us to visualize and understand the
interaction between multiple variables and a project’s design options and benefits.

Seer3D is versatile and yet very easy to learn and use. Chapter 1 of this text de-
scribes its main window and helps you getting started with the application. You can use
Seer3D to visualize a variety of raster and vector graphics that are described in Chapter
2. Chapter 3 explains the ways to display the numerical models and their results. Infor-
mative 3D scenes can easily be constructed by combining numerical models, raster and
vector datasets. The numerical models supported by Seer3D include the USGS ground-
water flow model MODFLOW, solute transport model MT3DMS, the variable density
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flow and transport model SEAWAT, and the reactive multi-component transport model
PHT3D, MT3D99, and RT3D. And finally, Chapter 4 explains how to add annotations
and logos and to create views that animates the 3D Scene by panning and rotating cam-
era between view points. This text assumes that you are already familiar with MOD-
FLOW, MT3DMS, and other transport models, and will not spend time on the basics of
groundwater flow and transport models.

The development of Seer3D spans over many years and it benefits from the issues
that we have encountered in its predecessors 3D Groundwater Explorer and 3D Mas-
ter. Many people tested and used Seer3D before it comes to you. Their contributions are
gratefully acknowledged. While testing and using Seer3D, we were often awed by its as-
tonishing graphic capability that is only possible with the generous contributions of open
source providers. Seer3D is mainly based on the Qt framework (http://qt.nokia.com), the
visualization toolkit (http://www.vtk.org), and SQLite (http://www.sqlite.com). These
great development toolkits make Seer3D a real eye-opener and I believe you will enjoy
it.

Eric W.H. Chiang
Simcore Software

Irvine, California, U.S.A. March 11, 2011
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Introduction

1.1 The Main Window of Seer3D

The main window of Seer3D and its features are shown in Figure 1.1 and described
below. The menus of the main window are described in the next section.

1. New: Discards all current settings and restarts Seer3D with a new project.
2. Open: Opens a project file previously saved by Seer3D. Seer3D project files have

”.s3d” file extensions.

Figure 1.1. The Main Window of Seer3D
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3. Save: Saves current scene in a Seer3D project file with the ”.s3d” file extension.
Data of all loaded objects are saved in the Seer3D project file, with the exception of
the result files of numerical models (see Chapter 3 for details). Seer3D only stores
the path and filenames of the result files in the project files.

4. Print: Prints the 3D scene.
5. Vertical Exaggeration: Defines the exaggeration factor. Use values greater

than 1 to emphasize vertical features. Use values smaller than 1 to deemphasize
vertical features.

6. Time Control toolbar: Controls the time
and animation. The time control is activated only if at least one of the displayed
graphical objects has time-varying properties. The time slider of the toolbar sets the
Current Time of the visualization. Graphical objects that have time-varying proper-
ties may have their own time control features, which may be synced with the Current
Time. The time span of the time slider is defined in the Project Settings dialog (see
Figure 1.7). You can create animation video of graphical objects that have time-
varying properties by following the steps below:
a) Click the button to turn on Recording feature. When Record is turned on, the

Record Options dialog box (Figure 1.2) appears.

Figure 1.2. The Record Options dialog box

b) Click the button in Figure 1.2 to select a folder where the video file should be
saved, enter the Base Filename, and then select a video format (AVI or HAV) and
a desired frame rate (i.e., number of frames per second when the video is played.).
AVI is a Microsoft video format that can be played back on most video players.
HAV (High quality Audio Video) is a lossless compressed format that can be
played back with the free Imagen multimedia player (www.gromada.com).

c) Click OK to create a video file that is ready to store animation sequences. For
example, the settings in Figure 1.2) will create a file called demo.hav in the
D:/Presentation folder.

d) Click one of the play buttons to start animation from the Current Time
forwards or backwards time step by time step or continuously until the time span
bound is reached. The length of a time step is defined in the Project Settings
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dialog (see Section 1.6). For each time step, an image will be captured and stored
in the video file that was created in the previous step.

e) Click the button to stop animation anytime.
f) Click the button to stop and finalize recording so the video file can be opened

by a video player.
7. Viewport: Displays graphical objects in a 3D scene. A graphical object is a visual

representation of geometric data such as terrain surface or a model grid. As long as
the consistent coordinate system (i.e., same origin and same length unit) is used by
all graphical objects, their spatial relationship will be displayed correctly.

8. Table of Contents (TOC): The TOC contains a list of predefined folders, e.g. Caption,
Image Overlay, etc. Each folder may contain a list of items, and each item represents
a graphical object. When an item is clicked and highlighted, it becomes an active
item and its properties are displayed in its Properties window (see Properties below
for details). Only one item can be active at a time. The major functions of the TOC
are:
• Right-click on a folder to display a pop-up menu. This allows the user to add,

remove, show, or hide items.
• Right-click on an item to display a pop-up menu with item-specific functions.
• The checkbox in front of a folder determines whether its items are displayed or

hidden.
• The checkbox in front an item determines whether the visual representation of its

data is displayed on the map or hidden. The data of a hidden item remains in the
computers memory. If an item is no longer needed, its removal is recommended.
To remove an item, right click on it and select Remove Item from the pop-up
menu.

9. Properties: Displays the properties of an active item. You can adjust the available
property values to change the appearance of the active item’s graphical object. All
items in Seer3D have the following common properties:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: Figure 1.3 illustrates an example of a

Crop Tool that consists of a box and 7 control handles (white spheres). The Crop
Tool is used together with Opacity and Drawing Mode to cut the graphical object.
You can drag the handles to modify the size of the box. Some items, such as
DXF or Shapefile, allow you to rotate the box horizontally by dragging one of its
faces. The portion of the graphical object that lies inside the box (i.e., the crop
area) are drawn by using the settings of Opacity (inside crop area) and Drawing
Mode (inside crop area). Similarly, the portion that lies outside the box are drawn
using the settings of Opacity (outside crop area) and Drawing Mode (outside
crop area). Visual effects can be achieved by assigning proper opacity values and
drawing modes to each of those areas. In Figure 1.3, for example, the opacity
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inside the crop area has been set to 50% to make the center portion of an aerial
photo translucent.

Figure 1.3. An example of a crop tool associated with an arial photo

• Coordinate Transformation: When a graphical object is created, Seer3D displays
the Coordinate Transformation dialog box (Figure 1.4), where you can enter the
desired transformation parameters, or just click OK to accept the default param-
eters. You can modify the transformation parameters any time by clicking the
button to open the Coordinate Transformation dialog box. The coordinate trans-
formation is done sequentially by applying translation, scale, and rotation param-
eters to all points of the graphical object. Note that a graphical object is scaled
from the Scale Center by multiplying the distance of each point to the Scale Cen-
ter by Scale Factor.

10. Navigation Tool: Enables the mouse to rotate, pan, and zoom graphical objects as
described below.
• Rotate: Position the mouse cursor within the Viewport, press and hold the left

mouse button, and move the mouse to rotate the graphical objects.
• Pan: Position the mouse cursor within the Viewport, press and hold the middle

mouse button, and move the mouse to drag the graphical objects. If the mouse
does not have a middle button, press and hold the Shift-key and the left mouse
button, then move the mouse to drag.
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Figure 1.4. The Coordinate Transformation dialog box

• Zoom in: Position the mouse cursor within the Viewport, press and hold the right
button, and move the mouse away from you. If your mouse has a scroll wheel, it
can be used to zoom in by scrolling it forward.

• Zoom out: Position the mouse cursor within the Viewport, press and hold the right
button, and move the mouse toward you. If your mouse has a scroll wheel, it can
be used to zoom in by scrolling it backward.

11. Zoom Tool: Zoomes to the extent defined by clicking and dragging a rectangle
over the area of interest

12. Zoom Extent: Zooms out to the extent that all graphical objects are visible.
13. Top View: Move the view point to look at graphical objects from top.
14. Bottom View: Move the view pointto look at graphical objects from bottom.
15. Left View: Move the view point to look at graphical objects from the left.
16. Right View: Move the view point to look at graphical objects from the right.
17. Front View: Move the view point to look at graphical objects from front.
18. Back View: Move the view point to look at graphical objects from back.
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1.2 The Menus of Seer3D

1.2.1 The File Menu

The File menu consists of the following items:

• New: Starts a new Seer3D project.
• Open: Opens a previously saved Seer3D project file (with the file extension .s3d) in

an Open dialog box. A Seer3D project file contains data and settings of all graphical
objects, with the exception of the simulation results of numerical models that are
often too big to be included. Instead of including result data, a link to the data file is
stored in the Seer3D file. If Seer3D cannot find the result file in its original path, the
application will search for the file in the folder where the Seer3D project file resides.
If a result file is not found, Seer3D will ask you to specify the file.

• Save: Saves the data of graphical objects and settings of the 3D scene in the Seer3D
project file with the exception of the simulation results of numerical models (see
Open above).

• Save As: Displays a Save As dialog box that lets the user to save data of graphical
objects and settings of the 3D Scene in a new file.

• Save Screen Shot: Displays a Save Image As dialog box that lets you save the current
3D scene in an image file in the JPG, PNG, or BMP format.

• Page Setup: Displays the Page Setup dialog box (Figure 1.5) that lets you define the
margin, orientation, logo, and description of the page.

• Print Preview: Displays a Print Preview dialog box.
• Print: Print the current 3D scene accrodint to the settings entered in Page Setup.
• Project Settings: Displays the Project Settings dialog box that contains three tabs as

described below.
– General Tab: As shown in Figure 1.6, the General tab contains settings of the

render window (i.e., the viewport), lights, and the maximum resolution of a loaded
image in terms of total number of pixels. Images larger than the given maximum
resolution will be resampled to fit the limit before loading into the 3D scene. The
original image files remain unmodified.

– Animation Tab (Figure 1.7): This defines the time span and time step of animation
sequences. The time span group defines the limits of the time slider in the Time
Control Toolbar. The animation (time) step defines the length of time that the
Current Time will move when the step forward button or the step backward
button is clicked.

– 3D Display Tab (Figure 1.8): This tab contains the Display Type dropdown box
that controls how the 3D scene is displayed. The default display type is Perspec-
tive Projection that mimics how graphical objects look to the human eye in the
real world, where objects appears to be smaller when they are further away from
the observer. In the second display type, Parallel Projection, an object will always
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Figure 1.5. The Page Setup dialog box

be drawn in the same size regardless of its distance from the observer. The third
display type, Anaglyph Red-Blue Stereo 3D, provides a stereoscopic 3D effect,
when viewed with glasses where the two lenses are of different colors (red and
blue). The 3D scene is made up of two color layers, superimposed, but offset with
respect to each other according to the Eye Angle to produce a depth effect. The
last display type, Quad-Buffered Stereo 3D, produces stunning 3D effects similar
to popular 3D movies. Quad-Buffered Stereo 3D display requires a graphic card
that supports OpenGL Quad Buffered Stereo (such as NVidia Quadro FX cards).
The monitor or projector must support stereo 3D (such as Viewsonic PJD6531w
3D-ready projector). In addition, 3D active shutter glasses that sync with the dis-
play are required. The following configuration has tested successfully:
* Computers running Windows 7 with Nvidia Quadro FX-380 or FX-580 graph-

ics card.
* Viewsonic PJD6531w 3D-ready (DLP-Link) projector connected to the graphic

card with a DVI to VGA cable (although the projector has an HDMI port, it
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Figure 1.6. The General tab of the Project Settings dialog box

Figure 1.7. The Animation tab of the Project Settings dialog box
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Figure 1.8. The 3D Display tab of the Project Settings dialog box

does not support stereo 3D). The 3D-Sync function of the projector is set to
DLP-Link.

* Viewsonic PGD-150 Stereo 3D glasses are used.
* To activate the 3D stereo display, a few simple settings of the display driver

need to be done correctly. In the 3D Settings of the NVIDIA Control Panel,
3D OpenGL Stereo is selected and the Stereo-Display Mode is set to NVidia
Recommended or Generic 3D Stereo. The display resolution of the projector
is set to 1280 x 720 with the Refresh rate of 120 HZ. The projector displays
frames for right and left eyes sequentially and the 3D glasses sync with display
through signals that are embedded between frames. Sometimes, it is necessary
to invert the left and right eye frame contents so that the eyes see the correct
frames. The inversion is done by pressing a button on the 3D Glasses.

• Exit: Ends Seer3D.

1.2.2 The View Menu

The items of the View menu have the same functions as the corresponding buttons in
the Main Window (Figure 1.1).
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1.2.3 The Help Menu

The Help menu contains the following items.

• User’s Guide: Displays this user’s guide.
• Seer3D on the web: Opens the web site of www.simcore.com on the default web

browser.
• About Seer3D: Displays the About Simcore Seer3D dialog box that you can use to

register or deregister the application. If unregistered, Seer3D runs as a 3D viewer that
can open s3d files, but cannot save them. See Section 5.2 for details about registration
and deregistration of Seer3D.



2

Raster and Vector Data

2.1 Digital Elevation Model

A digital elevation model (DEM) is a digital representation of ground surface topogra-
phy or terrain based on a raster of elevation values. Seer3D supports several DEM for-
mats, including Raster DEM (also known as ESRI ASCII Grid), SURFER Grid, SDTS
DEM, and the GridFloat format of the National Elevation Dataset (NED). Details of
these formats are described in Section 5.3.1.

I To add Digital Elevation Model to the 3D Scene

1. Right click on the Digital Elevation Model folder of the TOC to display a popup
menu.

2. Select Import from File from the popup menu to display an Open File dialog box,
select a DEM file and a file type, and then click OK to import the file.

3. Once the file is imported, the Coordinate System Conversion dialog box appears
(Figure 2.1), which can convert the coordinate system of the DEM file into another
one. Currently, the supported input coordinate systems are Universal Transverse
Mercator (UTM), Geographic, and State Plane; the supported output coordinate sys-
tems are UTM and State Plane. Most USGS DEM and SDTS datasets use the UTM
system; NED uses the Geographic system. As the Raster DEM and SURFER Grid
formats do not include projection information, the user has to determine the coordi-
nate of the data. Once the parameters are entered to the Projection dialog, click OK
to proceed with conversion; or click Skip Conversion to accept the original data.

4. Before a DEM model is displayed, the Coordinate Transformation dialog box ap-
pears (Figure 1.4), where you can enter the desired parameters to sequentially trans-
late, zoom (scale), and rotate the model, or just click OK to accept the default param-
eters. You can also define transformation parameters at a later time (see Properties
below).

5. Once the DEM is displayed, click on the newly added item to display its Properties
window that you can use to adjust the display settings as described in the Properties
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below. Figure 2.2 shows an example where two digital elevation models–one for
the ground surface and one for the bottom of aquifer–are used to depict the aquifer
thickness. Production wells and the well screens are displayed (see Section 2.3.5)
and an aerial photograph (see Section 2.2) is draped on the ground surface to provide
visual orientation.

Figure 2.1. The Coordinate System Conversion dialog box

Figure 2.2. Digital elevation models used to depict aquifer thickness. Production wells
and the well screens are displayed and an aerial photograph is draped on the ground
surface to provide visual orientation
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I Properties of Digital Elevation Model

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Resolution: Defines the visual resolution of the DEM. To ensure execution perfor-

mance, Seer3D automatically adjusts the resolution levels so that at most 50,000
elevation values are used for a DEM.

• Use Reference Surface As: Seer3D can display a ”solid” body between a DEM
and one or two reference surface(s). A reference surface can be another DEM or
a horizontal plane at a given elevation value.
– Select none if a solid body is not desired.
– Select bottom to create a ”solid” body between the DEM and the portion of the

reference surface that is lower than the DEM. If both Reference Surface 1 and
Reference Surface 2 are defined, the lower portion of the reference surfaces is
used.

– Select top to create a ”solid” body between the DEM and the portion of the
reference surface that is higher than the DEM. If both Reference Surface 1 and
Reference Surface 2 are defined, the higher portion of the reference surfaces
is used.

• Reference Surface 1 and Reference Surface 2:
– Enter none to remove the Reference Surface.
– Enter a numeric value to create a horizontal plane as the reference surface.

The entered value is the elevation of the plane.
– Click the button, and select a DEM file to define the reference surface. You

can also use a Scattered Data file that containing xyz values in place of a DEM
file. See Section 5.3.7 for the format of the Scattered Data file.

• Contour Levels: Click the button to open the Contour Levels dialog box (Fig-
ure 2.3) that contains a table showing levels and corresponding colors. You can
modify the table by using the following controls.
– Color Ramp: Select a predefined color ramp from this dropdown box to assign

graduated colors to the contour levels.
– Level: Click this button to open the Contour Level Ramp dialog box as shown

in Figure 2.4 that can be used to define the range of contour levels and the num-
ber of contours. If the values for Min Level and Max Level are both positive,
the option of Use logarithmic scale between Min and Max Levels is available.
Clicking on the Default button will reset the values of Min Level and Max
Level to the values found in the DEM model.

– Add: Click this button to open the Add Contour Level dialog box, where you
can enter a new contour level.

– Delete: To delete a contour level, first click on the desired contour level on the
table, then click this button.
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Figure 2.3. The Contour Levels dialog box

Figure 2.4. The Contour Level Ramp dialog box

2. Contour Lines:
• Visible: Select ”Yes” to display contour lines; select ”No” to hide contour lines.
• Width: The displayed width of contour lines in number of pixels.
• Color: The dropdown box defines the color of contour lines.

3. Contour Labels:
• Visible: Select ”Yes” to display contour labels; select ”No” to hide contour labels.
• Format and Precision: Select a format between decimal notation, scientific no-

tation, and compact format for the contour labels. If the format is decimal or
scientific notation, Precision is the number of digits after the decimal point. If
the format is compact, Precision is the number of significant digits. For example,
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if Precision is 3, 193.526218 will appear as 193.526 for the decimal notation;
1.935E+03 for the scientific notation; and 194 for the compact format.

• Distance: Defines the distance (expressed in the consistent length unit of the 3D
scene) between labels.

• Font size: Defines the height of label text. The height is expressed in the consistent
length unit of the 3D scene.

• Color: Defines the color of contour labels.
4. Legend:
• Visible: Select ”Yes” to display or ”No” to hide the legend of the contour levels.

Figure 2.5 shows an example of a legend with 6 labels.
• Title: Defines the title text of the legend.
• Horizontal position: Defines the horizontal position of the legend. The position

is measured from the left border of the Viewport to the left border of the legend
and expressed in percentage of the width of the Viewport.

• Vertical position: Defines the vertical position of the legend. The position is mea-
sured from the lower border of the Viewport to the lower border of the legend and
expressed in percentage of the height of the Viewport.

• Width: Defines the width of the legend as a percentage of the width of the View-
port.

• Height: Defines the height of the legend as a percentage of the height of the
Viewport.

• Text Color: Defines the color of the title and labels.
• Orientation: Defines whether a vertical or a horizontal legend should be dis-

played.
• Number of labels: Defines the number of labels of the legend.
• Format and Precision: Defines the format of the labels of the legend, see Format

and Precision of Contour Labels above for details.
• Font Type: Select a font type between Arial, Courier, and Times for the legend

title and labels.
• Bold Font: Check the box to use bold type face for the legend title and labels.
• Italic Font: Check the box to use italic type face for the legend title and labels.
• Text Shadow: Check the box to add text shadow to the legend title and labels.

5. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.

Figure 2.5. A legend with title text and labels
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2.2 Aerial Photograph and Raster Map

Aerial photographs or raster maps are digital maps on the basis of individual pixels
stored in specific bitmapped image formats, such png (Portable Network Graphics), jpg
(Joint Photographic Experts Group), or TIF (Tagged Image File). A bitmapped image
can be georeferenced and can be draped on a digital elevation model (Section 2.1), a
Contour Map (Section 2.4.2), or a horizontal plane at any elevation.

I To add Aerial Photograph or Raster Map to the 3D Scene

1. Right click on the Aerial Photo/Raster Map folder of the TOC to display a popup
menu, and then select Import from File from the popup menu to display an Open File
dialog box.

2. In the Open File dialog box, select an aerial photo or raster map file, then click OK to
import the file. Seer3D supports the png, jpg, bmp, tif, and tiff formats. Raster maps
usually consumes a lot of memory, as each point on the map must be represented
with a pixel and the color. Therefore, when a map is loaded Seer3D automatically re-
samples the map if it exceeds the maximum number of pixels defined in the Project
Settings dialog box (Figure 1.6).

3. Once the map file is imported, the World File Parameters dialog box appears (Figure
2.6). A raster map is usually accompanied by a world file that is a plain text data
file used to georeference the map. The format of the world file is given in Section
5.3.2. If a world file exists, Seer3D will import the file and display the parameters in
the World File Parameters dialog box. Enter or edit the parameters appropriately and
then click OK to import the map. If you click Cancel, the map will not be imported.

Figure 2.6. The World File Parameters dialog box
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I Properties of Aerial Photograph or Raster Map

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Projection Surface: Once a map is geo-referenced, it can optionally be draped

(projected) on a DEM model (Section 2.1), a Contour map (Section 2.4.2), or a
horizontal plane at the elevation defined by the Vertical Offset (see below).

2. Miscellaneous:
• Georeference: Click the button to display the World File Parameters dialog box

(2.6) where you can enter the desired parameters to geo-reference the map.
• Vertical Offset: The map is translated vertically by this value. For example, if a

map is draped on a DEM, this value can be used to ”lift” the map above the DEM.
If a map is draped on a horizontal plane, this value defines the elevation of the
plane.
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2.3 Vector Graphics

2.3.1 DXF

DXF (Drawing Interchange Format) is a CAD file format developed by Autodesk for
enabling data interoperability between AutoCAD and other programs. A DXF file con-
tains all the information of an AutoCAD drawing file, including data of various types of
graphical objects. Seer3D support the following graphical object types: POINT, LINE,
POLYLINE, LWPOLYLINE, ARC, CIRCLE, SOLID, TEXT, MTEXT. Graphical ob-
jects of not-supported types are ignored.

I To add DXF file to the 3D Scene

1. Right click on the AutoCAD DXF File folder of the TOC to display a popup menu.
2. Select Import from File from the popup menu to display an Open File dialog box.

Use the dialog box to select a DXF file, then click OK to import the file.
3. Once the file is imported, a Coordinate Transformation dialog box appears (Figure

1.4), where you can simply click OK to accept the default values or enter the desired
parameters to sequentially translate, zoom (scale), and rotate the graphical objects
contained in the DXF file. As CAD applications often save DXF files in various
coordinate systems, chances are that if the parameters are not correct, the DXF file
may be displayed in incorrect size or even completely outside of the Viewport. If
this happens, you can import the DXF file to a new instant of Seer3D, and then
add an Axes Box (see Section 4.4 for details) to display the coordinates of the DXF
file. Figure 2.7 illustrates an example of a DXF map and an Axes Box. Once the
coordinates of the DXF file is known, you can use the knowledge to find out the
correct coordinate transformation parameters.

I Properties of DXF file

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Projection Surface: After coordinate transformation is completed, graphical ob-

jects of a DXF file can optionally be draped (projected) on a DEM model (Section
2.1), a Contour map (Section 2.4.2), or a horizontal plane at the elevation defined
by the value of Vertical Offset (see below). If the option ”None (3D)” is chosen,
Seer3D draws the graphical objects using their x, y, and z coordinates. If the z
coordinate is not defined, the default value of zero is used.

• Layers: Click the button to open the DXF Layers dialog box as shown in Figure
2.8. Graphical objects of a DXF file are often grouped in separate layers. You can
use this dialog box to switch on or off individual layers. The layer colors cannot
be modified.
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Figure 2.7. A DXF map and an Axes Box showing the XYZ coordinates.

Figure 2.8. The DXF Layers dialog box

2. Point Symbol:
• Type: The dropdown box defines the symbol type that is used to drawn the POINT

graphical objects of the DXF file.
• Size: Defines the size of the POINT graphical objects. The size is expressed in

the consistent length unit of the 3D scene.
3. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
• Vertical Offset: The graphical objects of the DXF file is translated vertically by

this value after coordinate transformation and surface projection are completed.
For example, if a DXF map is draped on a DEM, this value can be used to ”lift”
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the map above the DEM. If a map is draped on a horizontal plane, this value
defines the elevation of the plane.

2.3.2 ESRI Shapefile

The ESRI Shapefile or Shapefile is a geospatial vector data format for geographic in-
formation systems software. The Shapefile format is developed by ESRI as an open
specification for data interoperability between software products of ESRI and other pro-
grams. Shapefiles include detailed data describing graphical shapes in the form of points,
polylines, and polygons. These graphical shapes could represents rivers, lakes, and mea-
surement data points. Each shape in a shapefile may have associated attribute fields, such
as name, depth of water, width of river, etc. A ”shapefile” actually consists of several
files. All files have the same base filename, but with different file extensions. The file
with the extension ”.shp” stores the geometrical data of each shape. The file with the ex-
tension ”.dbf” stores columnar attributes for each shape, in the dBase IV format. These
two files are required by Seer3D.

I To add Shapefile to the 3D Scene

1. Right click on the ESRI Shapefile folder of the TOC to display a popup menu.
2. Select Import from File from the popup menu to display an Open File dialog box.

Use the dialog box to select a Shapefile file, then click OK to import the file.
3. Once the file is imported, a Coordinate Transformation dialog box appears (Figure

1.4), where you can simply click OK to accept the default values or enter the desired
parameters to sequentially translate, zoom (scale), and rotate the graphical objects
contained in the Shapefile file. As shapefiles are often projected to various coordinate
systems, chances are that if the parameters are not correct, the Shapefile may be
displayed in incorrect size or even completely outside of the Viewport. If you have
access to ArcMap or GlobalMapper, you can use these applications to re-project
the shapefile to the coordinate system that is compatible to other graphical objects.
Alternatively, you can import the shapefile to a new instant of Seer3D, and then add
an Axes Box (see Section 4.4 for details) to display the coordinates of the shapefile.
Once the coordinates of the shapefile is known, you can use the knowledge to find
out the correct coordinate transformation parameters.

I Properties of Shapefile

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Projection Surface: After coordinate transformation is completed, a shapefile can

optionally be draped (projected) on a DEM model (Section 2.1), a Contour map
(Section 2.4.2), or a horizontal plane at the elevation defined by the value of
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Vertical Offset (see below). If the option ”None (3D)” is chosen, Seer3D draws
the graphical objects using their x, y, and z coordinates. If the z coordinate is not
defined, the default value of zero is used.

• Line Width: Defines the width of displayed line segments in pixels.
• Colors: Displays the color(s) that are currently in use. The colors can be defined

using the Symbology dialog box. To open the Symbology dialog box, click on
the button. (The Symbology dialog box is discussed below.)

• Fill Polygon: If this box is checked, all polygon features of the loaded shapefile
will be filled with the colors defined in the Symbology dialog box.

2. Point Symbol: If point features are present in the shapefile, Type defines the shape of
point features, and Size (expressed in the consistent length unit) defines the appear-
ance size of the point features. These definitions are ignored if point features are not
present.

3. Label:
• Label Field: This dropdown box contains the attribute fields for the selected

shapefile. Use this box to select a field that is used to label the displayed shapes.
• Orientation: Select ”fixed (always face up)” to display the labels facing the z-

direction; If the option ”face the user” is chosen, the labels will always face the
user.

• Font Size: Defines the height of the font expressed in the consistent length unit of
the 3D scene.

• Distance to Object: Defines the vertical distance between a label and a shape
expressed in the consistent length unit of the 3D scene.

• Color: Defines the color of the label.
4. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
• Vertical Offset: The graphical objects of the shapefile is translated vertically by

this value after coordinate transformation and surface projection are completed.
For example, if a shapefile is draped on a DEM, this value can be used to ”lift” the
map above the DEM. If a map is draped on a horizontal plane, this value defines
the elevation of the plane.

• Extrusion Height: If this value is not zero, all polygon features of the loaded
shapefile will be vertically extruded with the specified value.

I The Symbology dialog box
Shapefiles are associated with an attribute table that contains a number of value fields,
and each field contains values for each shape in the shapefile. The Symbology dialog
box (Figure 2.9) can be used to modify how these values are displayed. To open this
dialog box, click on the button of the Colors field in the Properties window of the
Shapefile. Three color-mapping styles are available and can be selected using the Style
dropdown box as described below. Once the color-mapping is defined, a legend identifies
the features of displayed shapefile will be displayed below the selected shapefile in
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the TOC. The checkboxes within this legend allow the user to show or hide respective
features.

1. Single Symbol (Figure 2.9): This is the default style and the easiest way to change
the color of a shapefile.
• Color: To select a color, click on the button in the Symbol group, choose a color

from the Select Color dialog box, and click OK.
• Label: Enter a descriptive text. The label and the selected color appears in the

TOC of the shapefile.
2. Unique Values (Figure 2.10): Seer3D can assign a color to each unique value within

a selected value field. For example, if a shapefile were to have a value field for
land use, a different color could be selected to represent each type of land use (i.e.
residential, commercial, agricultural, etc.).
• Value Field: This dropdown box contains the value fields for the selected shape-

file. Use this box to select a value field.
• Color Scheme: This dropdown box contains a number of pre-defined color

schemes. Use this box to select a color scheme.
• Symbol: This column displays the colors generated from the selected color

scheme. To change a particular color, double-click on it and choose a new color
from the Select Color dialog box.

• Value: This column displays the unique values (or strings) of the selected value
field. Values cannot be modified.

3. Graduated Colors (Figure 2.11): In this style, the quantitative values of a value field
are grouped into classes, and each class is identified by a particular color. A choro-
pleth map can also be displayed by mapping the quantitative values, such as concen-
tration, to a color ramp. For example, darker shades of red could be used to represent

Figure 2.9. The Symbology Dialog Box Single Symbol Style
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Figure 2.10. The Symbology Dialog Box Unique Value Style

Figure 2.11. The Symbology Dialog Box Graduated Colors Style

higher concentration values and lighter shades to could be used represent lower con-
centration values. The following describes the options available with the Unique
Values style:
• Fields Group: Use the Value dropdown box to select the field that contains the

desired quantitative values. Use the Normalization dropdown box to select a field
to normalize the data of the Value field. The quantitative values that are equal to
the optional No Data value will not be used to determine the lower and upper
bounds of the value range. Seer3D divides the data of the Value field by the data
of the Normalization field and uses the result for mapping.

• Classification Group: Use the Classes dropdown box to define the desired number
of classes to be displayed. Use the Color Ramp dropdown box to assign graduated
colors to the classes.
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• Range: Click this button to specify the lower and upper bounds of the quantitative
values to be mapped. The defined range is divided into equal-sized sub-ranges for
each class.

• Symbol: This column displays the colors of the individual classes. Colors are
defined by the selected color ramp. To change a particular color, double-click on
the displayed color box and choose a new color from the Select Color dialog box.

• Value: This column displays the lower and upper bounds of the individual classes.
To modify a value, double-click it and enter a new value.

2.3.3 Polyline

You can add polylines to the 3D Scene by importing Polyline files (see Section 5.3.4 for
the format) or by entering the coordinates of the nodes of polyline. Polylines are simple
and yet powerful features that are useful in many ways beyond drawing flow paths and
boundary lines. For example, you can use polylines to display geophysical data next to
well boreholes or display sparklines next to measurement points to present trends and
variations of measurement data.

I To add Polyline to the 3D Scene

1. Right click on the Polyline folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Polyline Data dialog

box (Figure 2.12), where you can import polyline files and/or edit polyline data. The
options of the Polyline Data dialog box are listed below.
• Polylines Group:

– The table displays a list of polylines with their attributes. You can hide a poly-
line by uncheck the corresponding check box in the table. You can select
a polyline by clicking on its name on the table. The nodes of the selected
polyline are displayed in the Nodes Group.

– Add: Click this button to add a polyline to the table.
– Delete: Click this button to delete the selected polyline.

• Nodes Group:
– The table displays a sequential list of nodes and their (x, y, z) coordinates of

the selected polyline.
– Add: Click this button to add a node/row to the bottom of the table.
– Delete: Click this button to delete the selected node.
– : Move the selected row one position up.
– : Move the selected row one position down.

• More Actions: Click this button to display a menu containing the following items:
– Import: Click this button to display a Open File dialog box. Use the dialog

box to select a Polyline file or a Pathline file created by MODPATH (Pollock,
[16]), then click OK to import polylines from the selected file and append them
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to the existing polylines. See Sections 5.3.4 and 5.3.3 for the formats of the
Polyline and MODPATH Pathline files, respectively. Note that the coordinates
stored in a MODPATH pathline file are expressed in a local coordinate system
of a MODFLOW model. To match with the model in the 3D Scene, these
coordinates need to be transformed with the same coordinate transformation
values of the model, with the exception that the value for the Y-translation
must be subtracted by the width (in the y-direction) of the model.

– Save: Click this button to save the polylines in a Polyline file.
– Clear: Click this button to delete all polylines.

• OK: Click OK to accept the polyline data.
3. Once the polyline data is accepted, the Coordinate Transformation dialog box ap-

pears (Figure 1.4), where you can simply click OK to accept the default values or
enter the desired parameters to sequentially translate, zoom (scale), and rotate the
polylines.

I Properties of Polyline

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Line Width: Defines the width of displayed polylines in pixels.

2. Source Data:
• Edit Data: Click the button to open Polyline Data dialog box (Figure 2.12)

where you can make changes to the polyline data.

Figure 2.12. The Polyline Data dialog box
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3. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.

2.3.4 Polygon

Seer3D provides an intuitive interface for adding polygons to the 3D Scene and assign-
ing textures to individual polygons. You can add polygons to the 3D Scene by importing
Polygon files (see Section 5.3.5 for the format) or by entering the coordinates of the
vertices of polygons. Polygons are primitive features that find many applications. For
example, you can use polygons to display cross-sections of geological layers, or you
can use complex polygons along with textures to display buildings. Note that nodes of
a polygon should be planar or near planar (i.e., pertaining to a plane).

I To add Polygon to the 3D Scene

1. Right click on the Polygon folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Polygon Data dialog

box (Figure 2.13), where you can import Polygon files and/or edit Polygon data. The
options of the Polygon Data dialog box are listed below.
• Polygons tab:

– Polygons Group:
* The table displays a list of polygons with their attributes. You can hide

a polygon by uncheck the corresponding check box in the table. You

Figure 2.13. The Polygon Data dialog box
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can select a polygon by clicking on its name on the table. The vertices of
the selected polygon are displayed in the Nodes Group to the right of the
dialog box.

* Add: Click this button to add a polygon to the table.
* Delete: Click this button to delete the selected polygon.

– Nodes Group:
* The table displays a list of vertices and their (x, y, z) coordinates of the

selected polygon. A polygon can be concave or convex, but must not self-
intersect. The first and last vertices do not need to be overlapped; Seer3D
will connect them to form a polygon.

* Add: Click this button to add a vertice/row to the bottom of the table.
* Delete: Click this button to delete the selected vertex.
* : Move the selected row one position up.
* : Move the selected row one position down.

• Texture tab: Use this tab to apply an image (or portions of an image) to polygon(s)
created in the Polygons tab. First, select a polygon from the Polygon dropdown
box, and then drag its vertices ( with a vertex number) to the corresponding
points on the image. For example, Figure 2.14 shows an image depicting a geo-
logical cross-section with the vertices 1 to 9 of a polygon that was entered in the
Polygon tab. Figure 2.15 illustrates the texture-mapped polygon on the 3D Scene.
If more than one polygon are defined in the Polygon tab, you can apply the same
texture image to other polygons. If you need to use a different texture image, then
you need to create a new Polygon object.

• More Actions: Click this button to display a menu containing the following items:
– Import: Click this button to display an Open File dialog box. Use the dialog

box to select a Polygon file, then click OK to import and append Polygons to
the existing Polygons. See Section 5.3.5 for the format of the Polygon file.

– Save: Click this button to save the polygons in a Polygon file.
– Clear: Click this button to delete all polygons.
– Load Texture Image: Click this button to open an Open File and select an im-

age file. Note that if the resolution of an image is higher than Maximum Reso-
lution defined in the Project Settings dialog box (see Page 6), the loaded image
is resized to fit the maximum resolution. The image file remains unaltered.

– Remove Texture Image: Click this button to remove the loaded texture image.
• OK: Click OK to accept the Polygon data.

3. Once the Polygon data is accepted, the Coordinate Transformation dialog box ap-
pears (Figure 1.4), where you can simply click OK to accept the default values or
enter the desired parameters to sequentially translate, zoom (scale), and rotate the
Polygons.
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Figure 2.14. The Texture tab of the Polygon Data dialog box

Figure 2.15. A polygon with a texture image
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I Properties of Polygon

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.

2. Source Data:
• Edit Data: Click the button to open the Polygon Data dialog box (Figure 2.13)

where you can make changes to the Polygon data.
3. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.

2.3.5 Well

The Well module can be used to display well casings, screen intervals, and lithology
logs. For example, Figure 2.16 shows a number of wells penetrating several aquifer
layers with the screen intervals shaded in blue. You can add wells to the 3D Scene by
importing Well files (see Section 5.3.6 for the format), by keying in the data directly, or
by querying data from a table in Microsoft Excel, Microsoft Access, or Microsoft SQL
database. Slanted wells are supported by specifying the azimuth, inclination, and length
of individual well segments. If you have measurement values along well boreholes, such
as geophysical data, you can display them by using the Polyline feature (Section 2.3.3).

I To add Well to the 3D Scene

1. Right click on the Well folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Well Data dialog box

(Figure 2.17), where you can import Well files and/or edit Well data. The options of
the Well Data dialog box are listed below.
• Wells Group:

– The table displays a list of wells with their attributes. You can hide a well by
uncheck the corresponding check box in the table. You can select a well
by clicking on its name on the table. The segments of the selected well are
displayed in the Segments Group on the right hand side of the dialog box.

– Add: Click this button to add a well to the table.
– Delete: Click this button to delete the selected well.
– Use Date/Time for Animation: If this box is checked, the installation date/time

of all wells must be specified and a well is displayed only if its installation
date/time is earlier than the date/time defined in the Time Control group of the
properties window (see Properties below). If this box is cleared, the data given
in the Installation Date/Time column are not used and all wells are always
displayed.
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Figure 2.16. Wells penetrating several aquifer layers

• Segments Group:
– The table displays a list of segments and their attributes of the selected well.

The attributes are as follows:
* Color: Color of the segment.
* Start Depth: The start depth of the segment measured from Top of Casing.
* Length: The length the segment.
* Azimuth: Orientation of the segment, measured in degrees clock-wise from

the north. This value is used only if Inclination is not zero.
* Inclination: Inclination is the angle (in degrees) between the vertical line

and the segment. A value of 0 defines a vertical segment pointing down-
wards; a value of 90 defines a horizontal segment.

– Add: Click this button to add a row to the bottom of the table.
– Delete: Click this button to delete the selected segment.
– Color: Use the Color box to select a color for all segments of the selected well.

• Master Color: Use the Master Color box to select a color for all segments of all
wells.

• More Actions: Click this button to display a menu containing the following items:
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Figure 2.17. The Well Data dialog box

– Import: Click this button to display an Open File dialog box. Use the dialog
box to select a Well file, then click OK to import and append wells to the
existing wells. See Section 5.3.6 for the format of the Well file.

– Save: Click this button to save the wells in a Well file.
– Import from Database: Click this button to open a Data Mapping dialog box

(Figure 2.18) for importing data from a supported database type. The available
options are:
* Database Connection:
· Database Type: Seer3D can import data from a worksheet of a selected

Microsoft Excel (*.xls) file, or from a table or a view of an Microsoft
Access Database (*.mdb) or a database on Microsoft SQL Server. Select
a database type that matches your data source.
· Database Name: Click the and select a database file if the Database

Type is Excel or Access. The file extension for a support Excel file is
.xls; the file extension for an Access file is .mdb. If the Database Type
is SQL Server, enter the name of the database here.
· Host Name, Username, Password: If the Database Type is SQL Server,

you need to establish a connection to the database by entering Host
Name (i.e., the name of the computer where the SQL server resides),
and a username and password combination that can be used to access
the desired table or view.
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· Connect: Click this button connect to a SQL database using the Host
Name, Username, Password combination.

* Data Source/Mapping:
· Table: The dropdown box contains a list of worksheets if the Database

Type is Excel, or contains a list of tables and views if the Database Type
is Access or SQL Server. From this dropdown box, select a worksheet
or table where the data is to be used.
· Data Mapping: The Data Mapping table is used to map the data from the

Preferred Field or Alternative Field of the selected table to the tables of
the Well Data dialog box. The Preferred Field will be used in most cases.
A selected Alternative Field will be used only if the Preferred Field is
”none” or if the value of the Preferred Field match the selected Criteria.
If both the preferred and alternative fields are ”none”, the Default Value
is used.

– Clear: Click this button to delete all wells.
3. OK: Click OK to accept the Well data and to display the Coordinate Transformation

dialog box (Figure 1.4), where you can simply click OK to accept the default values
or enter the desired parameters to sequentially translate, zoom (scale), and rotate the
Wells.

I Properties of Well

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Displayed Well Radius: Defines the radius for drawing well casing. The radius is

expressed in the length unit of the 3D scene.
2. Source Data:
• Edit Data: Click the button to open the Well Data dialog box (Figure 2.17)

where you can edit the well data.
3. Time Control:
• Mode: When Mode is set to Synchronized, Date and Time below are synced with

the Current Time on the Time Control toolbar (Figure 1.1). If Mode is Fixed, Date
and Time are fixed at their given values. Note that Mode is activated only if the
Use Date/Time for Animation box in the Well Data dialog box is checked.

• Date, Time: If the Use Date/Time for Animation box in the Well Data dialog box
is checked, a well is displayed only if its installation date/time is earlier than the
date/time defined here. If the Use Date/Time for Animation box is cleared, wells
are always displayed.

4. Label:
• Visible: Select ”Yes” to display labels using the well names defined in the Well

Data dialog box.
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Figure 2.18. The Data Mapping dialog box for well data

• Orientation: Select ”fixed (always face up)” to display the labels facing the z-
direction; if the option ”face the user” is chosen, the labels will always face the
user.

• Font Size: Defines the height of the font expressed in the consistent length unit of
the 3D scene.

• Distance to Object: Defines the vertical distance between a label and the top of
the well casing expressed in the consistent length unit of the 3D scene.

• Color: Defines the color of the label.
5. Scale:
• Visible: Select ”Yes” to display elevation or depth scales along well casing.
• Type: Defines the type of the scale to be displayed.
• Font Size: Defines the height of the font expressed in the consistent length unit of

the 3D scene.
• Tick Interval: Defines the interval between the scale labels.
• Color: Defines the color of the scale labels.

6. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
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2.4 Scattered Data

2.4.1 Point Map

The Point Map displays point symbols with user-defined labels. You can add a point
map to the 3D Scene by keying in data or by importing data from Scattered Data files
(see Section 5.3.7 for the format), Excel files, Access, or SQL databases.

I To add Point Map to the 3D Scene

1. Right click on the Point Map folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Scattered Data Points

dialog box (Figure 2.19), the options of the dialog box are:
• Data Columns: Each of the dropdown boxes contains a list of column names of

the data table. Use the X, Y, and Z dropdown boxes to select the columns that
contain the x, y, z coordinates, respectively.

• Data Table: The data table displays a list of (scattered) data points with their
coordinates and attributes.

• Add: Click this button to add a row to the table.
• Delete: Click this button to delete the selected rows. You can select a row by

clicking on it. You can select multiple rows by using Ctrl-click or click-and-drag.
• More Actions: Click this button to display a menu containing the following items:

Figure 2.19. The Scattered Data Points dialog box for Point Maps



2.4 Scattered Data 35

– Import: To import data from a scattered data file, click this button to display an
Open File dialog box, select a Scattered Data file, and then click OK to import
and append points to the existing ones.

– Import from Database: To import data from a database, click this button to
open a Data Mapping dialog box (Figure 2.20). The available options are:
* Database Connection:
· Database Type: Seer3D can import data from a worksheet of a selected

Microsoft Excel (*.xls) file, or from a table or a view of an Microsoft
Access Database (*.mdb) or a database on Microsoft SQL Server. Select
a database type that matches your data source.
· Database Name: Click the and select a database file if the Database

Type is Excel or Access. The file extension for a support Excel file is
.xls; the file extension for an Access file is .mdb. If the Database Type
is SQL Server, enter the name of the database here.
· Host Name, Username, Password: If the Database Type is SQL Server,

you need to establish a connection to the database by entering Host
Name (i.e., the name of the computer where the SQL server resides),
and a username and password combination that is used to access the
database.
· Connect: Click this button connect to a database using information given

above.

Figure 2.20. The Data Mapping dialog box for scattered data
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* Data Source/Mapping:
· Table: The dropdown box contains a list of worksheets if the Database

Type is Excel, or contains a list of tables and views if the Database Type
is Access or SQL Server. From this dropdown box, select a worksheet
or table where the data is to be used.
· Data Mapping: The Data Mapping table is used to map the data from

Preferred Field or Alternative Field of the selected table to the Data
Table. The Preferred Field will be used in most cases. A selected Al-
ternative Field will be used only if the Preferred Field is ”none” or if
the value of the Preferred Field match the selected Criteria. If both the
preferred and alternative fields are ”none”, the Default Value is used.

* OK: Click this button to accept the data mapping settings. If the Data Table
is empty prior to mapping data, new columns (X, Y, Z, Value, Data/Time,
and Optional) will be created for the Data Table. If the Data Table is al-
ready populated prior to mapping data, the values for X will be mapped to
the first column of the Data Table, the values for Y will be mapped to the
second column, and so on.

– Save: Click this button to save the data in a Scattered Data file.
– Clear: Click this button to delete all data points.

3. OK: Click OK to accept the Point data. Once the data is accepted, the Coordinate
Transformation dialog box appears (Figure 1.4), where you can simply click OK to
accept the default values or enter the desired parameters to sequentially translate,
zoom (scale), and rotate the point map.

I Properties of Point Map

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Projection Surface: After coordinate transformation is completed, data points can

optionally be draped (projected) on a DEM model (Section 2.1), a Contour map
(Section 2.4.2), or a horizontal plane at the elevation defined by the value of
Vertical Offset (see below). If the option ”None (3D)” is chosen, Seer3D draws
the data points using their x, y, and z coordinates.

2. Source Data:
• Edit Data: Click the button to open the Scattered Data Points dialog box (Fig-

ure 2.19) where you can make changes to the data points.
3. Point Symbol: Type defines the shape, Size (expressed in the consistent length unit)

defines the appearance size, and Color defines the color of the point symbols.
4. Label:
• Visible: Select ”Yes” to display labels; select ”No” to hide labels.



2.4 Scattered Data 37

• Column: This dropdown box contains the column names of the Data Table (Figure
2.19). Use this box to select a column that contains the desired labels for the data
points.

• Orientation: Select ”fixed (always face up)” to display the labels facing the z-
direction; If the option ”face the user” is chosen, the labels will always face the
user.

• Font Size: Defines the height of the font expressed in the consistent length unit of
the 3D scene.

• Distance to Symbol: Defines the vertical distance between a label and a data point
expressed in the consistent length unit of the 3D scene.

• Color: Defines the color of the label.
5. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
• Vertical Offset: The data points are translated vertically by this value after coor-

dinate transformation and surface projection are completed. For example, if data
points are projected on a DEM, this value can be used to ”lift” the points above
the DEM. If data points are projected on a horizontal plane, this value defines the
elevation of the plane.

2.4.2 Contour Map

Seer3D creates contour maps based on scattered data points and their attributes, includ-
ing measured values and measurement date/time. You can add a contour map to the 3D
Scene by keying in data or by importing data from Scattered Data files (see Section 5.3.7
for the format), Excel files, Access, or SQL databases.

I To add Contour Map to the 3D Scene

1. Right click on the Contour Map folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Scattered Data Points

dialog box (Figure 2.21). The options of this dialog are identical as those of Point
Map (see page 34), with the exception of Data Columns:
• Data Columns: Each of the dropdown boxes contains a list of columns of the data

table. Use the X, Y, and Z dropdown boxes to select the columns that contain the
x, y, and z coordinates, respectively. Use the Value dropdown box to select the
column that contains the measured values for the contours (it can be the z coordi-
nates if you want to create a terrain contour map.) If time-series are available at
all data points, contour map animation can be enabled by set the Time dropdown
box to the column that contains the date/time values. See the Time Control group
of Properties below for details about animation.

3. OK: Click OK to accept the scattered data set. Once the data is accepted, the Coordi-
nate Transformation dialog box appears (Figure 1.4), where you can simply click OK
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to accept the default values or enter the desired parameters to sequentially translate,
zoom (scale), and rotate the Contour Map.

I Properties of Contour Map

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Interpolation Parameters: To generate a contour map, Seer3D creates a rectilinear

grid and then interpolates the measurement values to each grid node by using the
parameters defined in the the Interpolation Parameters dialog box (Figure 2.22).
You can click on the button to open this dialog box that contains the following
parameters:
– Interpolation Method: Currently, the Modified Inverse Distance Weighting

method is available. This method is based on a paper published by Shepard
[19] that improves the pure inverse distance weighting method by adding func-
tions to (1) intellectively select nearby data points based on data density and
distribution, (2) include direction factor in addition to the distance factor in
the interpolation algorithm, and (3) include slope between data values in the
algorithm.

– Resolution: Numbers of Nodes (X) and Numbers of Nodes (Y) directions define
the resolution of the rectilinear grid. Preferred Number of Neighbors defines
the number of neighboring data points of a grid node that should be used to

Figure 2.21. The Scattered Data Points dialog box for Contour Maps
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estimate the value at the node. The actual number of data points varies based
on the spatial distribution of the data.

– Spatial Extent of the Grid: Defines the extent of the rectilinear grid by enter-
ing the coordinates of its lower-left (south-west) and upper-right (north-east)
corners. The coordinates are expressed in the same (and consistent) coordinate
system as the 3D Scene.

– Data Transform:
* Logarithmic Transform: Set to ”Yes” to log-transform the measured val-

ues prior to doing interpolation. This is typically necessary if the mea-
sured data is skewed, such as concentration measurements. Without log-
transformation, the estimates based on skewed data sets could be signifi-
cantly higher (over-estimation) because of the impact of high values.

* Replace Zero or Negative Values by: Prior to perform log-transform, the
measured values that are smaller than or equal to zero are replaced by the
value defined here.

• Contour Levels: See Contour Levels on page 13 for details.
2. Source Data:
• Edit Data: Click the button to open the Scattered Data Points dialog box (Fig-

ure 2.21) where you can make changes to the data points.

Figure 2.22. The Interpolation Parameters dialog box
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3. Time Control :
• If the Time dropdown box in the Scattered Data Points dialog box (Figure 2.21)

is set to ”none”, the Time Control group is deactivated and a static contour map is
created based on all data given in the Data Table of the Contour Map Data dialog
box.

• If time-series data (i.e., x, y, x, measured value, and measurement date/time) are
entered in the Data Table and the Time dropdown box is set to the column con-
taining the date/time information, Seer3D creates a contour map for the time point
defined by Date/Time in the following steps.
– The value for each spatial location at the time point is determined by linear

interpolation of the time-series data. If the time point lies beyond the range
of a time-series, the value of the measurement date/time that is closest to and
within the time tolerance to the time point is used for the spatial location.

– The determined values at all spatial locations are used for gridding by using
the parameters defined in the Interpolation Parameters dialog box (see above),

– The gridded results are used to draw the contour map.
• When Mode is set to Synchronized, Date/Time are synced with the Current Time

on the Time Control toolbar (Figure 1.1). Contour map animation can be created
by using the Play (forward or backward) button of Time Control toolbar, which
programmatically creates contour maps at a series of time points. If Mode is
Fixed, Date/Time are fixed at their given values and consequently the contour
map is fixed at the given time point.

4. Contour Lines, Contour Label, Legend: See respective items on page 14 for details.
5. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.

2.4.3 Isosurface

Seer3D creates isosurfaces based on scattered data points and their attributes, including
measured values and measurement date/time. You can add isosurfaces to the 3D Scene
by keying in data or by importing data from Scattered Data files (see Section 5.3.7 for
the format), Excel files, Access, or SQL databases.

I To add Isosurface to the 3D Scene

1. Right click on the Isosurface folder of the TOC to display a popup menu.
2. Select Create New Object from the popup menu to display the Scattered Data Points

dialog box (Figure 2.21). The options of this dialog are identical as those of Point
Map (see page 34, with the exception of Data Columns:
• Data Columns: Each of the dropdown boxes contains a list of columns of the

data table. Use the X, Y, and Z dropdown boxes to select the columns that contain
the x, y, and z coordinates, respectively. Use the Value dropdown box to select
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the column that contains the measured values for the isosurface. If time-series
are available at all data points, you can enable isosurface animation by setting
the Time dropdown box to the column that contains the date/time values. See the
Time Control group of Properties below for details about animation.

3. OK: Click OK to accept the scattered data set. Once the data is accepted, the Coordi-
nate Transformation dialog box appears (Figure 1.4), where you can simply click OK
to accept the default values or enter the desired parameters to sequentially translate,
zoom (scale), and rotate the Isosurface.

As soon as the Coordinate Transformation dialog box is closed, the measurement values
at the data points are interpolated to grid nodes of a three-dimensional rectilinear grid,
and then an isosurface is created based on the interpolated grid values. By default, as
illustrated in Figure 2.23 an isosurface is opaque and conceals the concentration distri-
bution inside the isosurface. You can reveal the distribution contours by using the Crop
Tool with appropriate property settings of the Opacity values and Drawing Modes to cut
through the isosurface. For example, Figure 2.24 shows contours along the faces of the
Crop Tool; the portion of the isosurface outside the crop area is represented by a mesh
with a lower opacity value. With the help of the crop tool, great visual effects can be
easily created by combining graphical objects with various opacity values and drawing
modes.

I Properties of Isosurface

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Interpolation Parameters: The parameters are identical as those of the Contour

Map, with the exception of data for the z-dimension and the Anisotropy factor.
The latter allows Seer3D to take into account the effects of anisotropy. For a given
node of a rectilinear grid, the vertical distance values between the scattered data
points and the node are multiplied by the anisotropy factor before they are used
in the interpolation process. With the increase of the anisotropy factor, the gener-
ated isosurface will become more ’flatter’ as data points in the vertical directions
become further away and less influential.

• Contour Levels: See Contour Levels on page 13 for details.
• Upper Bounding Surface and Lower Bounding Surface: In Seer3D, you can con-

straint the isosurface below an upper bounding surfaces, above a lower bounding
surface, or between lower and upper bounding surfaces. To define a bounding sur-
face, click on the button, and then select a file from an Open File dialog box.
Acceptable digital elevation model file formats are described in Section 5.3.1.
In addition, you can use scatter data files that contains x, y, z in its first three
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Figure 2.23. An isosurface with the default display settings.

Figure 2.24. An isosurface with portions cropped away to reveal the concentration dis-
tribution
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columns. To define a horizontal bounding surface, simply enter its elevation to
the edit box and then press Enter.

2. Source Data:
• Display Option:

– Hide: Select this option to hide all scattered data points.
– Show All: Select this option to display all scattered data points.
– Inside Crop Area Only: Select this option to display scattered data points

which lie inside of the crop area (See Properties on page 3 for details about
crop area.)

• Edit Data: Click the button to open the Scattered Data Points dialog box (Fig-
ure 2.21) where you can make changes to the scatter data set.

• Min. Radius: Scattered data points are represented by spheres graphically. Min.
Radius is used to as the radius of the spheres of the data points with the smallest
measured value. The radius for data point with the highest measured values is set
as three time larger than Min. Radius.

• Color Below Min: This is used for the spheres with the measured values that are
smaller than the lowest contour level.

• Color Above Max: This is used for the spheres with the measured values that are
larger than the highest contour level.

3. Time Control: See Time Control on page 40 for details.
4. Legend: See Legend on page 15 for details.
5. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
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Numerical Models

3.1 Import Model

Seer3D supports the USGS groundwater flow model MODFLOW (Harbaugh et al., [7, 9,
10]), the transport model MT3DMS (Zheng, [20]) and SEAWAT (Langevin et al.,[12]),
and a number of reactive transport models such as MT3D99 (Zheng, [21]), PHT3D
(Prommer and Post, [17]), and RT3D (Clement, [4]).

Seer3D imports a MODFLOW model by using its Name File (*.nam) that contains
paths and names of all input and output files of the model. The format of the Name File
is described in Harbaugh et al. [7, 9, 10]. Seer3D reads the geometry of the model from
its discretization file that is required since MODFLOW-2000. Model data sets for older
versions of MODFLOW might not contain this file. In that case, Seer3D expects the dis-
cretization file discret.dat in the same folder as the Name File. The following outlines
the procedures for importing a Modflow model.

I To import Modflow Model to the 3D Scene

1. Right click on the MODFLOW folder of the Table of Content to display a popup
menu.

2. Select Import from File from the popup menu to display a Modflow Model dialog
box (Figure 3.1).

3. In the Modflow Name File group of the Modflow Model dialog box, click on the
button to open an Open File dialog box, and then select a Name file.

4. In the Simulated Time Frame group, specify the starting date and time of the simu-
lation. If you have several models or other data sets, it is important to set the time
correctly so that the display of the model is synchronized with others when the Cur-
rent Time on the Time Control toolbar 1.1 is changed. If only a steady-state flow
model is loaded, the settings of this group is irrelevant.

5. The Default Values group contains the head values for dry, no-flow, or inactive cells.
These values are read from the model input file and will be used by Seer3D to iden-
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Figure 3.1. The Modflow Model dialog box

tify the cell status. The default values should not be changed unless you have specific
reasons to do so.

6. Click OK to accept the settings of the Modflow Model dialog box, Seer3D will import
the model. Once the model is imported, the Coordinate Transformation dialog box
will appear (Figure 1.4), where you can simply click OK to accept the default values
or enter the desired parameters to sequentially translate, zoom (scale), and rotate the
model.

As soon as the Coordinate Transformation dialog box is closed, the imported model will
be displayed in the 3D scene and a model item will be added to the Modflow Model
folder of the TOC (Figure 3.2). By default, the model outline, fixed head cells, and cells
of the loaded flow packages (such as River, Well, etc.) are displayed. The model item
will have a number of child items representing the Model Grid, the loaded flow pack-
ages, and model results (such as Groundwater Table, Flow Vector, Pathline/Streamline,
etc.). The properties of the model item are described below. The child items of the model
item are discussed in detail in the reminder sections of this chapter.

I Properties of Modflow Model

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Model Starting Date/Model Starting Time: Starting date and time of the model

simulation.
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Figure 3.2. The 3D Scene showing a Modflow Model

2. Time Control :
• Mode: When Mode is set to Synchronized, Date and Time below are synced with

the Current Time on the Time Control toolbar (Figure 1.1). If Mode is Fixed, Date
and Time are fixed at their given values.

• Date, Time, Stress Period, Time Step: The Model Time is defined by the given
date/time. Stress Period and Time Step of the model are determined by using
the Model Time and the starting date/time of the simulation (see Figure 3.1).
Seer3D displays the configuration of model packages at the determined stress pe-
riod and uses the model results that are linearly interpolated to the Model Time.
You can set Mode to Synchronized and use the Time Control toolbar (Figure 1.1)
to control the display of the model packages and results over the simulated time
period.Note that if the Model Time lies outside of the time span of the flow sim-
ulation, only the Model Grid will be visible. This can easily happen because a
number of steady-state flow models usually simulate for a very short time span.
If you run a transport simulation for a long period based on a steady-state flow
model, its flow simulation time span should be set long enough so that you can
visualize the transport results in seer.
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3. Result Files
• Head: This file contains the calculated hydraulic head values. The file must be

saved in the ’true’ binary format (i.e., without markers or headers of records that
some FORTRAN compilers added between actual result values). You can click
on the button to select a new file.

• Cell-By-Cell Flow: This file contains the calculated cell-by-cell flow terms (some-
time called cell-by-cell budget file). Similar to the Head file, this file must be
saved in the ’true’ binary format. You can click on the button to select a new
file.

• Concentration: This file contains the concentration values calculated by MT3DMS,
SEAWAT, RT3D, PHT3D, MT3D99, etc. As a MODFLOW Name file does not
contain the information about transport models, this file is usually not known and
needs to be specified by the user. However, the file mt3d001.ucn will be used
here by default, if it is found in the same folder as the Name file. Similar to the
Head file, the Concentration file must be saved in the ’true’ binary format. You
can click on the button to select a new file.

4. Default Value
• Head for No-Flow Cells: If the calculated hydraulic head values equal to this

value, they will be ignored by Seer3D. This value is given in the model input file
to pre-determine head values for inactive model cells where no flow takes place.
You should not change this value unless do it knowingly for specific purposes.

• Head for Dry Cells: If the calculated hydraulic head values equal to this value,
they will be ignored by Seer3D. This value is given in the model input file to
pre-determine head values for model cells that went dry during the course of
simulation. You should not change this value unless do it knowingly for specific
purposes.

• Concentration: If the calculated concentration values equal to this value, they will
be ignored by Seer3D. This value is given in the model input file to pre-determine
concentration values for inactive concentration cells, where no transport simula-
tion takes place. You should not change this value unless do it knowingly for
specific purposes.

• Effective Porosity: The value is used to calculate pore velocity when drawing
Flow Vector (see Section 3.4.3), or calculating pathline (see Section 3.4.4). You
can type a value for the entire model or click on the button to select a 3D
ASCII Matrix file that defines the effective porosity values at individual cells.
See Section 5.3.8 for the format of 3D ASCII Matrix file.

5. Miscellaneous:
• Coordinate Transformation: See Properties on page 3 for details.
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3.2 Model Grid

When a model is loaded, only the model outline and the fixed-head cells are displayed
and the drawing mode is set as Mesh. Active cells and inactive cells are not displayed so
that they will not obstruct the cells of the loaded flow packages and model results. You
can modify the appearance of the model grid by using model grid’s property window as
outlined below.

I Properties of Model Grid

1. General:
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Smooth: If this box is checked, the elevations of the corners of model cells are

modified to produce smooth layer surfaces. Group Smooth by Cell Status deter-
mines how the modification is done.

• Group Smooth by Cell Status: if this box is not checked, the elevation of a cell’s
corner is set to the average elevation of all cells surrounding the corner and lying
in the same layer as the cell, to which the corner belongs. If this box is checked,
only the surrounding cells of the same status (either IBOUND = 0 or IBOUND
6= 0) as the cell are used for determining the average. This box should be check
this box, if the inactive cells do not have correct elevation values.

2. Model Outline:
• Visible: Check this box to turn on the display of the model outline that is a bound-

ing box encompassing all cells of the model.
• Line Width: Defines the width in pixels used to draw the model outline.
• Color: Defines color of the model outline.

3. Fixed Head Cells:
• Visible: Check this box to turn on the display of the fixed head cells of the model.

In MODFLOW, a fixed head cell is defined by setting its IBOUND value to an
integer smaller than 0.

• Color: Defines the color of the fixed head cells.
4. Inactive Cells:
• Visible: Check this box to turn on the display of the inactive cells of the model.

In MODFLOW, an inactive cell is defined setting its IBOUND value to 0.
• Color: Defines the color of the inactive cells.

5. Active Cells:
• Visible: Check this box to turn on the display of the active cells of the model. In

MODFLOW, an active cell is defined setting its IBOUND value to an interger
greater than 0.

• Color: click on the button to open the Layer Settings dialog box (Figure 3.3),
where you can define the color and the visibility of the top, side, and bottom of
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the model layers. You can click the column headers to set the color or values to
all layers in one single step.

Figure 3.3. The Layer Settings dialog box
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3.3 Flow Packages

When a model is loaded, the flow packages that describe the hydraulic stresses (e.g., the
well package) and boundary conditions (e.g., the river package) are displayed with de-
fault settings. You can adjust the settings of each of the packages by using its Properties
window.

All Properties windows of the flow packages have the common General and Display
Settings sections that are similar to those of the Model Grid (see Section 3.2) and can be
used to set color(s) and opacity values of the model cells of the respective flow packages.
In addition, each of the following packages has an additional section in the Properties
window for controlling the display of package-specific features as outlined below.

• Drain: The Drain Elevation section is used to control the display of the elevation of
the drain assigned to each of the drain cells.

• General-Head Boundary: The Specified Head Level on GHB section is used to con-
trol the display of the head level assigned to each of the general-head boundary cells.

• Lake: The Body of Water section is used to control the display of the area between
the Top and Bottom elevation assigned to each cell of the Lake2 package [5].

• Reservoir: The Body of Water section is used to control the display of the area be-
tween the stage and elevation of the reservoir bed assigned to each cell of the Reser-
voir package [6].

• River: The Body of Water section is used to control the display of the area between
the Head in river and elevation of the bottom of riverbed assigned to each cell of the
River package.

• Stream-Flow Routing: The Body of Water section is used to control the display of the
area between the stream stage and the bottom of riverbed assigned to each cell of the
Stream-flow Routing package [18].

• Time-Variant Specified Head: The Specified Head Level section is used to control
the display of the specified head assigned to each cell of the Time-Variant Specified
Head package [13].
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3.4 Modeling Results

3.4.1 Groundwater Table

In Seer3D, the Groundwater Table is defined by the highest head values of the model
columns at the Model Time.

I To add Groundwater Table to the 3D Scene

1. Right click on the Groundwater Table folder of the model on the TOC to display a
popup menu. Note that the Groundwater Table folder is available only when the re-
sult file containing the calculated hydraulic head values is specified in the Properties
window of the model (see Properties of Section 3.1).

2. Select Create New Object from the popup menu. The groundwater table will be
created and displayed with the default settings. A new item will be added to the
Groundwater Table folder (Figure 3.4).

3. Click on the Groundwater Table item to display its Properties window that you can
use to adjust the display settings.

Figure 3.4. The Groundwater Table of a model
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I Properties of Groundwater Table

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Resolution:Select a display resolution of the groundwater table and its contour

lines. For larger models, it is recommended to use the lowest resolution when
experimenting various settings and use the high or highest resolution for presen-
tation.

• Contour Levels: See Contour Levels on page 13 for details.
• Ignore Dry Areas in Confined Layers: If this box is checked, the groundwater

table will not be drawn for cells in confined layers where the head values are
lower than the cell bottom. For unconfined layers, the groundwater table will
never be created for dry cells.

2. Contour Lines, Contour Label, Legend: See respective items on page 14 for details.
Note that the range of the contour levels are calculated based on the hydraulic head
values at the Model Time when the groundwater table is created. For a transient
flow model, the calculated range of contour levels might not cover the range of head
values at another time point. In that case, you should adjust contour levels as needed.

3.4.2 Hydraulic Head Contours

Contours of the calculated hydraulic head values at the Model Time can be created on a
selected model layer, or on a vertical slice along a model column or row.

I To add Hydraulic Head Contours to the 3D Scene

1. Right click on the Hydraulic Head Contours folder of the model on the TOC to
display a popup menu. Note that the Hydraulic Head Contours folder is available
only when the result file containing the calculated hydraulic head values is specified
(see Properties of Section 3.1).

2. Select Create New Object from the popup menu. The head contours will be cre-
ated with the default settings and a new item will be added to the Hydraulic Head
Contours folder (Figure 3.5).

3. Click on the newly added Head Contour item to display its Properties window that
you can use to adjust the display settings as described in the Properties below.

I Properties of Hydraulic Head Contours

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
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Figure 3.5. The Hydraulic Head Contours of a model

• Resolution:Select a display resolution of the contours. For larger models, it is
recommended to use the lowest resolution when experimenting various settings
and use the high or highest resolution for presentation.

• Orientation: Defines whether the head contours are created on a model layer, a
model column, or a model row.

• Layer: The number of the model layer where the contours should be created. The
layer is numbered from top down. This control is available only if the Orientation
is Layer.

• Column: The number of the model column where the contours should be created.
This control is available only if the Orientation is Column. Note that a contour
map along a model column makes sense only if the model has at least three layers.

• Row: The number of the model row where the contours should be created. This
control is available only if the Orientation is Row. Note that a contour map along
a model row makes sense only if the model has at least three layers.

• Contour Levels: See Contour Levels on page 13 for details. Note that the range
of the contour levels are calculated based on the hydraulic head values at the
Model Time when the head contours item is created. For a transient flow model,
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the calculated range of contour levels might not cover the range of head values at
another time point. In that case, you should adjust contour levels as needed.

• Ignore Dry Areas in Confined Layers: If this box is checked, the head contours
will not be created for cells in confined layers where the head values are lower
than the cell bottom. For unconfined layers, the head contours will never be cre-
ated for dry cells.

2. Contour Lines, Contour Label, Legend: See respective items on page 14 for details.
Note that contour lines and labels are only available when the Orientation is Layer.

3.4.3 Flow Vector Field

Seer3D creates flow vector fields with flow vectors attached to model cells. The magni-
tude and direction of flow vectors are calculated based on the effective porosity and the
simulated cell-by-cell flow terms and hydraulic head values at the Model Time. Flow
vector fields are often used together with streamlines or pathlines (see Section 3.4.4) to
visualize the speed and direction of the groundwater movement.

I To add Flow Vector Field to the 3D Scene
1. Right click on the Flow Vector folder of the model on the TOC to display a popup

menu. Note that the Flow Vector folder is available only when the calculated head
and cell-by-cell flow terms are available.

2. Select Create New Object from the popup menu. The flow vectors will be created
and displayed with the default settings and a new Flow Vector item will be added to
the TOC (Figure 3.6).

3. Click on the Flow Vector item to display its Properties window that you can use to
adjust the display settings as described in the Properties below.

I Properties of Flow Vector Field
1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Ignore Dry Areas in Confined Layers: If this box is checked, flow vectors will

not be created for cells in confined layers where the head values are lower than
the cell bottom. For unconfined layers, flow vectors will never be created for dry
cells.

2. Vector:
• Data Type: Seer3D can draw vectors based on one of the following three data

types and their logarithmic variants.
– Flow Volume: The vectors, thar�are attached to model cells, are scaled by using

the volume of groundwater flowing through the model cells.
– Darcy Velocity: The vectors are scaled by using the Darcy velocity at model

cells.
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Figure 3.6. The flow field of model with flow vectors converge on three pumping wells
represented by red rectangles.

– Pore Velocity: The vectors are scaled by using the pore velocity, which is equal
to the Darcy velocity divided by the effective porosity.

• Color: Defines the color of the flow vectors.
• Size: This defines the length of the vector representing the highest magnitude of

flow volume, Darcy velocity, or pore velocity. The vectors are scaled according
to their magnitudes between 0 and Size. The value of Size is expressed in the
consistent length unit of the 3D scene.

• Lower Threshold: If the lower threshold is not equal to -1, only the flow vectors
with a magnitude greater than the lower threshold are displayed. If -1 is entered,
the lower threshold does not apply.

• Upper Threshold: If the upper threshold is not equal to -1, only the flow vectors
with a magnitude smaller than the upper threshold are displayed. If -1 is entered,
the upper threshold does not apply.

3. Column/Row/Layer: These values define the region of interest which is bound by
the start and end model columns, rows, and layers. Only the flow vectors that lie
within the region of interest are displayed. The Interval values specify how often the
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vectors should be displayed. For example, if start row is 5, end row is 14, and the
row interval is 3, then the vectors at the rows 5, 8, 11, and 14 are displayed.

3.4.4 Flow Path

Seer3D uses a semi-analytical particle-tracking scheme (Pollock [15]) to calculate
streamlines or pathlines based on the calculated hydraulic head values, the calculated
cell-by-cell flow terms, and the starting locations and release times of particles. Pathlines
are the routes that individual water particles travel from their release time to the Model
Time under the simulated steady-state or transient flow conditions. Streamlines depict
the instantaneous groundwater flow field at the Model Time. Pathlines and streamlines
are often used together with flow vectors (see Section 3.4.3) to visualize the speed and
direction of the groundwater movement. Note that you can import and display Pathline
files created by MODPATH (Pollock [16]) to the 3D Scene, see Section 2.3.3 for details.

I To add Flow Path to the 3D Scene

1. Right click on the Flow Path folder of the model on the TOC to display a popup
menu. Note that the Flow Path folder is available only when the calculated head and
cell-by-cell flow terms are available.

2. Select Create New Object from the popup menu to display the Particle Starting Lo-
cations dialog box (Figure 3.7). The options of the dialog box are as follows.

Figure 3.7. The Particle Starting Locations dialog box
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• Data Table: The data table displays a list of particles with their attributes as fol-
lows.
– Column, Row, Layer: These are the column, row, and layer indexes of the cell

containing the particle. The origin of the column, row, and layer indexes is the
upper-left-top cell of the model (see Figure 5.2 on page 83.)

– u, v, w: The values of u, v, and w are local coordinates (ranging between 0 and
1) that define the position of a particle within a cell. The origin of u, v, w is
the upper-left-top corner of the cell (see Figure 5.2 on page 83.)

– Retardation: The travel velocity of a particle is set to its pore velocity divided
by Retardation. Particles move slower with a larger Retardation value.

– Time: This is the release time of a particle measured in the model’s Time Unit
(see Figure 3.1) since the start of the flow simulation. For pathlines, if the
release time is earlier than the Model Time, the particle will move forward
in time (forward tracking) until the Model Time or the end of simulation is
reached; if the release time is later than the Model Time, the particle will move
backward in time (backward tracking) until the Model Time or the beginning
of simulation is reached. In other words, if you want to calculate pathlines by
backward tracking, you need to set the release time to the end of the simulation
and set the Model Time to the beginning of the simulation.

• Add: Click this button to add a row to the table.
• Delete: Click this button to delete the selected rows. You can select a row by

clicking on it. You can select multiple rows by using Ctrl-click or click-and-drag.
• Action: Click this button to display a menu containing the following items:

– Import: Click this button to display an Open File dialog box. Use the dialog
box to select a Particles file or a Starting Location file, then click OK to import
and add the particles to the Data Table. See Section 5.3.9 for the acceptable
file formats. Note that you can use PMPATH (Chiang [1][2][3]) to create a ac-
ceptable file by selecting File > Save Particle As and then saving the particles
using the file type ”Starting position”.

– Save: Click this button to save the data table in a Particles file.
– Clear: Click this button to delete all particles.

As soon as the Particle Starting Locations dialog box is closed, the streamlines will be
calculated and displayed by default (Figure 3.8). You can use the Properties window
as described below to switch to pathlines or modify other particle tracking parameters.
Seer3D calculates the flow path of a particle until any of the following stop conditions
is met:

1. When the pathline is being calculated and the Model Time is reached.
2. When the pathline is being calculated and the start or end of the simulated time span

is reached.
3. The particle enters a cell with internal sink during forward tracking.
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4. The particle enters a cell with internal source during backward tracking.
5. The particle enters a cell with no possibility of escaping the cell.

I Properties of Flow Path

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.

2. Particles:
• Edit Data: Click the button to open the Particle Starting Locations dialog box

(Figure 3.7) where you can edit the particles.
3. Simulation Options:
• Particle Tracking Mode: Select the tracking mode between Streamline and Path-

line.
• Recharge: This option is applicable only if the Recharge package is used in the

model. Be default, MODFLOW treats recharge as an internal distributed source
of a cell and does not assign it to any of the six cell faces. In that case, the flow
velocity across the top face of the top model layer is zero, and particles cannot

Figure 3.8. Flow paths of a model depicting the upstream capture zones of three pumping
wells
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be tracked backwards to the top face where recharge occurs mostly. In Seer3D,
recharge may be treated as a distributed source, or assigned to the top face or
bottom face of a cell by selecting a corresponding option from the dropdown list.

• Evapotranspiration: This option is applicable only if the Evapotranspiration
package is used in the model. Similar to Recharge, evapotranspiration can be
assigned to top face of a cell or treated as a distributed sink.

4. Forward Tracking Options/Backward Tracking Options:
• Active: Check this box to activate forward or backward particle tracking.
• Time Unit: This the unit of the Max Tracking Time and Time Mark Interval below.
• Max Tracking Time: This is the maximum amount of time that a particle may

travel since its release. Max Tracking Time is expressed in the Time Unit defined
above.

• Time Mark Interval: Seer3D can place time marks on the flow paths. Time Mark
Interval is the amount of time between two time marks and is expressed in the
Time Unit defined above.

• Time Mark Type: This defines the shape of the time marks. Select none to turn off
the time marks.

• Time Mark Size: This defines the size of the time marks using the same consistent
length unit as the 3D Scene.

• Time Mark Color: This defines the color of the time marks.
• Line Color: This option defines the color of the displayed flow paths.
• Line Width: This is the width of the displayed flow paths in pixels.

3.4.5 Concentration Contour

Contours of the calculated concentration values at the Model Time can be created on a
model layer, or on a vertical slice along a model column or row.

I To add Concentration Contour to the 3D Scene

1. Right click on the Concentration Contours folder of the model on the TOC to dis-
play a popup menu. Note that the Concentration Contours folder is available only
when the result file of calculated concentration values is specified (see Properties of
Section 3.1).

2. Select Create New Object from the popup menu. The concentration contours will be
created with the default settings and a new item will be added to the Concentration
Contours folder (Figure 3.9).

3. Click on the newly created item to display its Properties window that you can use to
adjust the display settings.
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Figure 3.9. Concentration contours depicting results of a MT3DMS model

I Properties of Concentration Contour

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Resolution: Select a display resolution of the groundwater table and its contour

lines. For larger models, it is recommended to use the lowest resolution when
experimenting various settings and use the high or highest resolution for presen-
tation.

• Orientation: Defines whether the head contours are created on a model layer, a
model column, or a model row.

• Layer: The number of layer where the hydraulic contours should be created. The
layer is numbered from top down. This control is available only if the Orientation
is Layer.

• Column: The number of model column where the hydraulic contours should be
created. This control is available only if the Orientation is Column. Note that a
contour map along a model column makes sense only if the model has at least
three layers.
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• Row: The number of model row where the hydraulic contours should be created.
This control is available only if the Orientation is Row. Note that a contour map
along a model row makes sense only if the model has at least three layers.

• Contour Levels: See Contour Levels on page 13 for details. Note that the range of
the contour levels are calculated based on the concentration values at the Model
Time when the concentration contours item is created. The calculated range might
not cover the range of concentration values at another time point. In that case, you
should adjust contour levels as needed.

2. Contour Lines, Contour Label, Legend: See respective items on page 14 for details.
Note that contour lines and labels are only available when the Orientation is Layer.

3.4.6 Concentration Isosurface

A concentration isosurface is usually used to depict the extent of a plume at a given
concentration limit. Seer3D creates concentration isosurface of a model by using the
calculated concentration values at the Model Time.

I To add a concentration isosurface to the 3D Scene

1. Right click on the Concentration Isosurface folder of the model on the TOC to dis-
play a popup menu. Note that the Concentration Isosurface folder is available only
when the result file of calculated concentration values is specified (see Properties of
Section 3.1).

2. Select Create New Object from the popup menu. The concentration isosurface will
be created with the default settings and a new item will be added to the Concentration
Isosurface folder (Figure 3.9). In much the same way as described in Section 2.4.3,
the Crop Tool, opacity values, and drawing modes can be used to create various
display effects. Figure 3.10 illustrates an example where the isosurface of a model
is cropped to reveal the concentration distribution on a vertical cross-section along a
face of the crop tool.

3. Click on the newly added item to display its Properties window that you can use to
adjust the display settings.

I Properties

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Resolution:Select a display resolution of the isosurface and its contours. For

larger models, it is recommended to use the lowest resolution when experiment-
ing various settings and use the high or highest resolution for presentation.

• Contour Levels: See Contour Levels on page 13 for details. Note that the range of
the contour levels are calculated based on the concentration values at the Model
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Figure 3.10. Concentration isosurface and contours based on the model results. The
contours are automatically created on the face of the Crop Tool.

Time when the concentration isosurface item is created. The calculated range
might not cover the range of concentration values at another time point. In that
case, you should adjust contour levels as needed.

2. Legend: See page 14 for details.
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3.5 Parameter Distribution

The spatial distribution of model parameter values, such as hydraulic conductivity, can
be displayed in the form of contours along a model layer, or on a vertical slice along a
column or a row of the model.

I To add Parameter Distribution Contours to the 3D Scene

1. Right click on the Parameter Distribution Contours folder of the model on the TOC
to display a popup menu.

2. Select Create New Object from the popup menu, and then select a 3D ASCII Matrix
file (See Section 5.3.8 for the format) from an Open File dialog box. The parameter
distribution contours will be created with the default settings and a new item will be
added to the Parameter Distribution Contours folder. Figure 3.11 shows the distribu-
tion of hydraulic conductivity values at a model layer and the streamlines that trace
the area of higher hydraulic conductivity values. Note that 3D Matrix file format is
supported by Processing Modflow 8 (Chiang [3]).

3. Click on the newly added item to display its Properties window that you can use to
adjust the display settings.

Figure 3.11. Streamlines and the distribution of hydraulic conductivity values
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I Properties of Parameter Distribution

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Crop Tool, Opacity, and Drawing Mode: See Properties on page 3 for details.
• Resolution:Select a display resolution of the contours. For larger models, it is

recommended to use the lowest resolution when experimenting various settings
and use the high or highest resolution for presentation.

• Orientation: Defines whether the head contours are created on a model layer, a
model column, or a model row.

• Layer: The number of the model layer where the contours should be created. The
layer is numbered from top down. This control is available only if the Orientation
is Layer.

• Column: The number of the model column where the contours should be created.
This control is available only if the Orientation is Column. Note that a contour
map along a model column makes sense only if the model has at least three layers.

• Row: The number of the model row where the contours should be created. This
control is available only if the Orientation is Row. Note that a contour map along
a model row makes sense only if the model has at least three layers.

• Contour Levels: See Contour Levels on page 13 for details.
2. Contour Lines, Contour Label, Legend: See respective items on page 14 for details.

Note that contour lines and labels are only available when the Orientation is Layer.
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View and Annotation

4.1 View

A view retains the settings of the view angle and zoom level of a 3D Scene. You can add
as many views as needed and then switch between them with simple mouse-clicks.

I To add View to the TOC

1. Right click on the View folder on the TOC to display a popup menu.
2. Select Create New View from the popup menu. A new view item will be created and

added to the View folder. The view angle and zoom level of the current 3D Scene is
stored in the newly created item.

3. Once you have modified the view angle and zoom level of the 3D Scene, you can
update a view item with the new view angle and zoom level by right-clicking on the
item and then selecting Update from a popup menu.

4. You can switch to a saved view by right-clicking on the view item and then selecting
Go to from a popup menu.

I Properties of View

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Transition Style: This determines how Seer3D displays the transition from other

view to the current one when ”Go to” is selected. If the transition style is ”Instan-
taneous”, the 3D Scene is switched to the selected view instantaneously. If the
transition style is ”Animated”, the 3D Scene is transited to the selected view grad-
ually in a number of steps as defined in Transition Steps. Note that the transition
style is always instantaneous, if the display type of a view is ”Parallel Projection”
(see Figure 1.2.1 on page 6).

• Transition Steps: Defines the number of steps for the transition style ”Animated”.
This value is not used if the transition style is ”Instantaneously”.



68 4 View and Annotation

4.2 Caption

Captions can be added to the Viewport to clearly identify the subject of the visualiza-
tion scene. A caption is fixed on the viewport and does not transform with the graphical
objects in the 3D Scene.

I To add Caption to the Viewport

1. Right click on the Caption folder on the TOC to display a popup menu.
2. Select Create New Object from the popup menu. A caption will be created and dis-

played with the default settings. A new item will be added to the Caption folder.
3. Click on the newly added item to display its Properties window that you can use to

adjust the display settings as described in the Properties below. Figure 4.1 shows an
example of a caption on the top-left corner of the 3D scene.

I Properties of Caption

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Show Box: Check this box to add the bounding box of the caption to the display.
• Color: Defines the color of caption and the bounding box.

Figure 4.1. A caption on the top-left corner of the Viewport to identify the subject of the
image
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2. Text Properties:
• Text: This is the caption text. One of a caption’s primary purposes is to identify

the subject of the picture. You can create a multi-line caption by copy and paste a
multi-line text from a text editor to this box.

• Font Type: Select a font type between Arial, Courier, and Times for the caption.
• Horizontal position: Defines the horizontal position of the caption. The position

is measured from the left border of the Viewport to the left border of the caption
and expressed in percentage of the width of the Viewport.

• Vertical position: Defines the vertical position of the legend. The position is mea-
sured from the lower border of the Viewport to the lower border of the caption
and expressed in percentage of the height of the Viewport.

• Font Size: Defines the size of caption text. The font size scales with the Viewport.
• Line Spacing: Defines the space between each line of a multi-line caption.
• Bold Font: Check this box to use bold type face for the caption.
• Italic Font: Check this box to use italic type face for the caption.
• Text Shadow: Check this box to add text shadow to the caption.
• Show Date: Check this box to add the date portion of the Current Time (i.e., the

time defined on the toolbar) to the caption.
• Show Time: Check this box to add the time portion of the Current Time to the

caption.
• Date Format: Select a format for the date portion of the Current Time.
• Time Format: Select a format for the time portion of the Current Time.
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4.3 Image Overlay

Images or graphic logos can be added as an image overlay to the Viewport to aid and
promote instant public recognition of the company or organization. An overlay image is
fixed on the viewport and does not transform with the graphical objects in the 3D Scene.

I To add Image Overlay to the Viewport

1. Right click on the Image Overlay folder on the TOC to display a popup menu.
2. Select Create New Object from the popup menu, and select an image file from the

Open File dialog box, then click Open. The image will be loaded and displayed with
the default settings. A new item will be added to the Image Overlay folder.

3. Click on the newly added item to display its Properties window that you can use to
adjust the display settings as described in the Properties below. Figure 4.2 shows an
example of a logo on the lower-left corner of the Viewport.

I Properties of Image Overlay

1. General:
• Name: Defines the name of the item as it appears on the TOC.

Figure 4.2. A logo on the lower-left corner of the Viewport to promote public recognition
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2. Image Properties:
• Horizontal position: Defines the horizontal position of the overlay image. The

position is measured from the left border of the Viewport to the left border of the
overlay image and is expressed in percentage of the width of the Viewport.

• Vertical position: Defines the vertical position of the overlay image. The position
is measured from the lower border of the Viewport to the lower border of the
overlay image and is expressed in percentage of the height of the Viewport.

• Size: Defines the size of overlay image.
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4.4 Axes Box

An Axes Box is an axis-aligned bounding box that can be added to the 3D Scene to
display the measure of graphical objects in the 3D space.

I To add Axes Box the Viewport

1. Right click on the Axes Box folder on the TOC to display a popup menu.
2. Select Create New Object from the popup menu. An axis-aligned bounding box will

be created and displayed. A new item will be added to the Axes Box folder. By
default, the bounding box will encompass all visible graphical objects in the 3D
Scene.

3. Click on the newly added item to display its Properties window that you can use to
adjust the display settings as described in the Properties below. Figure 4.3 shows an
example of an axis-aligned bounding box and the X and Y axes around the outer
edge of a model.

Figure 4.3. An axis-aligned bounding box showing X and Y axes around a model
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I Properties of Axes Box

1. General:
• Name: Defines the name of the item as it appears on the TOC.
• Resize Tool:
• Bounding Box:
• Axis Bounds: Click on the button to define the lower and upper bounds of the

X, Y, and Z axes.
• Axis Color: Defines the color of the axes.

2. X-Axis, Y-Axis, and Z-Axis:
• Visible: Select ”Yes” to display or ”No” to hide the axis.
• Title: This is the title text of the axis.

3. Font:
• Number of labels: Defines the number of labels along an axis.
• Format and Precision: Select a format between decimal notation, scientific nota-

tion, and compact format for the axis labels. If the format is decimal or scientific
notation, Precision is the number of digits after the decimal point. If the format is
compact, Precision is the number of significant digits. For example, if Precision
is 3, 193.526218 will appear as 193.526 for the decimal notation; 1.935E+03 for
the scientific notation; and 194 for the compact format.

• Title Color: Defines the color of the title text of the axes.
• Label Color: Defines the color of the labels of the axes.
• Font Type: Select a font type between Arial, Courier, and Times for the title text

and labels.
• Font Size: Define the font size of the title text and labels.
• Bold Font: Check the box to use bold type face for the title text and labels.
• Italic Font: Check the box to use italic type face for the title text and labels.
• Text Shadow: Check the box to add text shadow to the title text and labels.
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Supplemental Information

5.1 System Requirements

5.1.1 Minimum Requirements

• Operating System: Microsoft Windows XP or Windows 7 32-bit or 64-bit.
• CPU: Pentium 4, 2.4 GHz+ or AMD 2400xp+
• System Memory (RAM): 2 GB
• Hard Disk: 2 GB of free disk space
• Graphics Card: 3D-capable video card with 256 MB of Video RAM or greater.
• 1280x1024, ”32-bit True Color” screen

5.1.2 Recommended Configuration for Quad-Buffered 3D Stereographic
Display

Seer3D has been successfully tested to display Quad-Buffered 3D stereoscopic images.
See Section 1.2.1 for the configuration example and driver settings. The typical hardware
configuration of the testing computers are given below.

• Operating System: Microsoft Windows XP or Windows 7 32-bit or 64-bit.
• CPU: Intel Core 2 Quad or higher.
• System Memory (RAM): 4 GB
• Hard Disk: 20 GB of free disk space
• Graphics Card: nVidia Quadro FX 380 or higher.
• 3D-Ready DLP-Link projector, such as Viewsonic PJD6531w connected to the

graphic card with a DVI to VGA cable.
• Active stereographic 3D shutter glasses using the DLP-Link technology, such as

Viewsonic PGD-150.
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5.2 Setup Seer3D

5.2.1 Installing Seer3D

I To install Seer3D, follow these steps:

1. Download the Seer3D setup file from www.simcore.com.
2. Unzip the contents of the downloaded file to a clean folder.
3. Double click the setup.exe file to start the installation. After the installation is com-

pleted, select Start > All Programs > Simcore Software > Seer3D > Seer3D to start
the application. You can also start Seer3D by double-clicking on a Seer3D project
file (i.e., a file with the extension ”.s3d” ).

4. Register Seer3D and unlock it to a full version with a product key. To register, select
Help > About Seer3D to open the About Simcore Seer3D dialog box, click the
Register button, and then enter the product key into a dialog box. You can purchase
a product key from www.simcore.com or from an authorized distributor. Without
the key, Seer3D is locked to a Demo Mode and works as a Seer3D Viewer that can
open existing Seer3D project files. In addition, the Demo Mode allows you to load a
MODFLOW model with up to 5,000 cells and 3 stress periods.

5. You can deregister Seer3D by selecting Help > About Seer3D to open the About
Simcore Seer3D dialog box, and then click the Deregister button.

5.2.2 Uninstalling Seer3D

I To uninstall Seer3D from Windows XP, follow these steps:

1. Click Start > Settings > Control Panel.
2. Double-click Add or Remove Programs.
3. Find Seer3D, and click it.
4. Click on Remove, and then click Yes.

I To uninstall Seer3D from Windows 7, follow these steps:

1. Click Start > Control Panel.
2. Click Uninstall a program.
3. Find Seer3D, and click it.
4. Click on Uninstall, and then click Yes.
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5.3 File Formats

5.3.1 Digital Elevation Model

• ASCII Grid and Raster DEM: The format is relatively straight-forward: the first
six lines indicate the reference of the grid, followed by the values listed in the order
they would naturally appear (left-right, top-down). Figure 5.1 shows an ASCII grid
file representing a grid and its values. The variables of of the ASCII grid file are
described below.
– ncols and nrows are the numbers of columns and rows, respectively (represented

as integers);
– xllcorner and yllcorner are the western (left) x-coordinate and southern (bottom)

y-coordinates, such as easting and northing (represented as real numbers with an
optional decimal point).

– cellsize is the length of one side of a square cell (a real number).
– nodata value is the value that is regarded as ”missing” or ”not applicable”; this

line is optional, but highly recommended as some programs expect this line to be
declared.

– The remainder of the file lists the raster values for each cell, starting at the upper-
left corner. These real numbers (with optional decimal point, if needed) and are
delimited using a single space character.

Figure 5.1. Raster DEM Format. Adapted from WikiPedia.
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• SURFER Grid: SURFER uses either ASCII (plain text) files or their own binary
grid format. SURFER’s ASCII file format is:

DSAA
ncols nrows
Xmin Xmax
Ymin Ymax
Zmin Zmax
Row 1: Z11 Z12 Z13 ... Z1n
Row 2: Z21 Z22 Z23 ... Z2n
Row 3: Z31 Z32 Z33 ... Z3n
...
Row M: ZM1 ZM2 ZM3 ... ZMn

– DSAA: The first line holds the ASCII (text) string ”DSAA” that serves as the file
format identifier.

– ncols and nrows are the numbers of columns and rows, respectively.
– Xmin Xmax are the minimum and maximum x values, respectively.
– Ymin Ymax are the minimum and maximum y values, respectively.
– Zmin Zmax are the minimum and maximum z values, respectively.
– The remainder of the file lists the raster (z-) values for each cell, starting at

the lower-left corner. These numbers are delimited using a single space character.
Note that in SURFERs reckoning, the first row is the one associated with the
minimum value of y and represents the bottom edge of your map. The last row is
the top edge of the map. The leftmost value in each row is that associated with the
minimum x, the rightmost goes with the maximum x.

• NED GridFloat: The National Elevation Dataset (NED) serves the elevation layer of
The National Map, and provides basic elevation information for earth science stud-
ies and mapping applications in the United States. Scientists and resource managers
use NED data for global change research, hydrologic modeling, resource monitor-
ing, mapping and visualization, and many other applications. The elevation data are
available from the NED in a seamless, nationally consistent form through the USGS
The National Map Seamless Server http://seamless.usgs.gov.

• SDTS DEM: The SDTS DEM data files saved in the format according to the Spatial
Data Transfer Standard (SDTS) and were produced by the U.S. Geological Survey
(USGS) as part of the National Mapping Program. Most of the SDT DEM files have a
resolution of 10 m or 30 m (an elevation data at each 10 m or 30 m spacing) and use
the Universal Transverse Mercator (UTM) coordinate system. As of the writing of
this document, SDTS appears to become obsolete as the National Elevation Dataset
is easier to use.
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5.3.2 World File

A world file is a plain text computer data file used by a number of geographic informa-
tion systems to georeference raster map images. The file specification was introduced
by ESRI. The name of the world file is based on the raster file’s name. One convention
is to append the letter ”w” to the end of the filename. For example, the world file of
mymap.jpg is mymap.jpgw. An alternative naming convention removes the second let-
ter of the original filename and adds the letter ”w” at the end. For example, the world
file of mymap.jpg is mymap.jgw. A world file contains 6 lines, and each line contains a
single parameter as described below.

Format:

1. PixelSizeX: pixel size in the x-direction in map units/pixel.
2. RotateY: rotation angle about the y-axis.
3. RotateX: rotation angle about the x-axis.
4. PixelSizeY: pixel size in the y-direction in map units, almost always negative.
5. X: x-coordinate of the center of the upper left pixel.
6. Y: y-coordinate of the center of the upper left pixel.

5.3.3 MODPATH Pathline File

MODPATH (Pollock, [16]) can save its calculated pathlines in Standard Text Pathline
or Compact Text Pathline file formats. Both formats are supported by Seer3D and can
be imported as polylines (see Section 2.3.3).

A Standard Text Pathline or Compact Text Pathline file begins with the header of the
form:

@ [ MODPATH 5.0 (TREF= 0.000000E+00 ) ]

The header is followed by a sequence of particle location records that contain the fol-
lowing data items in the order specified below. Seer3D only uses the first 5 values of
each record, i.e., the values in the [] brackets are not used and can be omitted.

Standard Text Pathline Format:

1. Particle index number
2. Global coordinate in the x-direction
3. Global coordinate in the y-direction
4. Local coordinate in the z-direction within the cell
5. Global coordinate in the z-direction
6. [Cumulative tracking time]
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7. [J index of cell containing the point]
8. [I index of cell containing the point]
9. [K index of cell containing the point]

10. [Cumulative MODFLOW time step number]

Compact Text Pathline Format:

1. Particle index number
2. Global coordinate in the x-direction
3. Global coordinate in the y-direction
4. Local coordinate in the z-direction within the cell
5. Global coordinate in the z-direction
6. [Cumulative tracking time]
7. [Global node number of cell containing the point]
8. [Cumulative MODFLOW time step number]

5.3.4 Polyline File

Polyline files can be imported to Seer3D (see Section 2.3.3). A polyline file is a text file
that contains a number of data blocks, and each block contains the data of a polyline.
Lines start with # are ignored. The format of the data block is described below. The
values in the [] brackets are optional.

Format:

• NumberOfNodes, [ColorCode], [IsVisible], [Name].
• x, y, z: Coordinates of a node. Repeat NumberOfNodes times.

Description:

• NumberOfNodes: number of nodes of a polyline..
• ColorCode (default value is 0 if omitted): This defines the color of the polyline and

the value ranges between 0 and 16. Each value corresponds to a color as following:
0: white, 1: black, 2: red, 3:darkRed, 4: green, 5: darkGreen 6: blue; 7: darkBlue; 8:
cyan; 9: d arkCyan; 10: magenta; 11: darkMagenta; 12: yellow; 13: darkYellow; 14:
gray; 15:darkGray; 16:lightGray.

• IsVisible (default value is 1 if omitted): IsVisible = 1: the polyline is displayed by
default. IsVisible = 0: the polyline is not displayed by default. Note that you can
switch on/off the display of individual polylines after they are imported.

• Name: Name of the polyline.
• x, y, z: Coordinates of a node. Repeat NumberOfNodes times.
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5.3.5 Polygon File

Polygon files can be imported to Seer3D (see Section 2.3.4). A polygon file is a text file
that contains a number of data blocks, and each block contains the data of a polygon.
The polygon file format is identical as the polyline file format described above.

5.3.6 Well File

Well files can be imported to Seer3D to depict well or lithology profiles. See Section
2.3.5 for how to import well files. A well file is a text file that contains a number of data
blocks, and each block contains the data of a well. Lines start with # are ignored. The
format of the data block is described below. The values in the [] brackets are optional.

Format:

• NumberofSegments, X, Y, TOC, [IsVisible], [Name], [InstallationDateTime].
• ColorCode, StartDepth, Length, [Azimuth], [Inclination]: Data of a segment. Re-

peat NumberofSegments times.

Description:

• NumberofSegments: number of segments of a well.
• X, Y: coordinates of the well.
• TOC: Top of casing of the well.
• IsVisible (default value is 1 if omitted): IsVisible = 1: the well is displayed by default.

IsVisible = 0: the well is not displayed by default. Note that you can switch on/off
the display of individual wells after they are imported.

• Name: Name of the well.
• InstallationDateTime: Date and time when the well is installed. Vaild formats are

given below, where YYYY stands for 4 digit year value (e.g. 2010), MM stands for
month, DD stands for the day in a month, HH stands for hours (in 24 hour format),
MM stands for minutes, and SS stands for seconds.
– YYYY-MM-DD
– MM-DD-YYYY
– MM/DD/YYYY
– DD.MM.YYYY
– YYYY-MM-DD HH:MM:SS
– MM-DD-YYYY HH:MM:SS
– MM/DD/YYYY HH:MM:SS
– DD.MM.YYYY HH:MM:SS

• ColorCode: This defines the color of the a segment of the well. The value of Col-
orCode ranges between 0 and 16. Each value corresponds to a color as following:
0: white, 1: black, 2: red, 3:darkRed, 4: green, 5: darkGreen 6: blue; 7: darkBlue; 8:
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cyan; 9: d arkCyan; 10: magenta; 11: darkMagenta; 12: yellow; 13: darkYellow; 14:
gray; 15:darkGray; 16:lightGray.

• StartDepth: This is the start depth of the well segment measured from the Top of
Casing (TOC).

• Length: This the length of the well segment.
• Azimuth (default value is 0 if omitted): Orientation of the well segment, measured in

degrees clock-wise from the north. This value is used only if Inclination is not zero.
• Inclination (default value is 0 if omitted): Inclination is the angle (in degrees) be-

tween the vertical line and the segment. A value of 0 defines a vertical segment; a
value of 90 defines a horizontal segment.

5.3.7 Scattered Data File

Scattered Data files are used to create Point Map, Contour Map, or Isosurface. A Scat-
tered Data file is a text file that contains a number of rows. Each row contains the data of
a point, including X, Y, Z coordinates and the multivariate values measured at the given
coordinate. Lines start with # are ignored. The values in the [] brackets are optional.

Format:

["col1" "col2" "col3" "col4" "col5" "colx"]
X1 Y1 Z1 V11 V12... V1k
X2 Y2 Z2 V21 V22... V2k
...
Xi Yi Zi Vi1 Vi2... Vik
...
Xn Yn Zn Vn1 Vn2... Vnk

Description:

• [”col1” ”col2” ”col3” ”col4” ”col5” ”colx”]: Column names can be optionally de-
fined in the first line. The names must be enclosed by double quotation marks and
separated by at least one blank, for example ”x” ”y” ”z” ”concentration” ”time”.

• Xi, Yi, and Zi: These are the coordinates of the point i;
• Vi1, Vi2, ..., Vik: These are measured values at the point i; k is the number of the

variables. All points must have the same number of variables.

5.3.8 3D ASCII Matrix File

A 3D ASCII Matrix file is a text file stored in the following format that can be imported
to Seer3D to create contour maps representing the spatial distribution of parameter val-
ues of MODFLOW models, see Section 3.5. Note that you can use Processing Modflow
(Chiang, [3]) to save and read model parameters in this format.
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Format:

• NCOL, NROW, NLAY, nodata value.
• 2D Array. Repeat the 2D array NumberOfNodes times.

Description:

• NCOL, NROW, NLAY: These are the numbers of columns, rows, and layers, re-
spectively. When loading a 3D ASCII Matrix file to a model, these numbers must be
identical as the dimension of the model.

• nodata value is the value that is regarded as ”missing” or ”not applicable”.
• 2D Array: This a 2D array of the size [NROW x NCOL] that contains values for

each of the model cells in a layer. The 2D array is stored in the format as described in
the Array Reading Utility Subroutines of the user’s guide of MODFLOW (Harbaugh
[10]). The following example illustrates a 3D ASCII Matrix file of a model with
[NCOL, NROW, NLAY]=[5, 4, 2].

5 4 2 -99999
11 1(5G8.0) -1

7.63 7.7 7.35 6.59 6.08
7.66 7.93 7.62 7.22 6.64
6.55 6.98 7.62 7.99 7.64
6.05 6.37 7.07 7.43 7.43

11 1(5G8.0) -1
8.38 8.58 8.1 6.83 6.1
8.31 8.84 8.41 7.33 6.6
6.66 7.14 7.67 8.03 8.38
6.06 6.43 7.4 8.37 8.92

5.3.9 Particle Start Location File

A Particle Start Location file stores the starting locations and times of particles that can
be imported to Seer3D for calculating flow paths of a MODFLOW model, see Section
3.4.4. Several formats are supported by Seer3D as given below. The values in the []
brackets are optional.

• Format 1: Seer3D saves particles in this format.
– #SEER3D V100 PARTICLES: The first line holds this string that serves as the

file format identifier.
– I, J, K, u, v, w, [r, t]. A line contains the data for a starting location. Repeat as of-

ten as needed. Refer to Figure 5.2, [I, J, K] are the [column, row, layer] indexes of
the cell containing the starting location; [u, v, w] are the local coordinates (rang-
ing from 0 to 1) of the starting location within the cell. The origin of [I, J, K] is
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the highest northwest corner of the model and the origin of [u, v, w] is the highest
northwest corner of a cell. r is the retardation factor. The velocity of a particle
is set to its ambient groundwater flow velocity divided by the retardation factor.
Particles move slower with larger values of retardation factor. t is the release time
measured from the beginning of the flow simulation in the same time unit as the
model.

• Format 2
– #SEER3D V100 PARTICLES: The first line holds this string that serves as the

file format identifier.
– x, y, z, [t]. A line contains the data for a starting location. Repeat as often as

needed. Refer to Figure 5.2, [x, y, z] are the coordinates of the starting location;
the origin of [x, y, z] is the lowest northwest corner of the model. t is the release
time measured from the beginning of the flow simulation in the same time unit as
the model.

Figure 5.2. Coordinate systems used by Format 1 and Format 2.

• Format 3: PMPATH (Chiang, [2][3]) saves particles in this format.
– #PMPATH V100 PARTICLES: The first line holds this string that serves as the

file format identifier.
– u, v, w, I, J, K, z, c, r. A line contains the data for a starting location. Repeat

as often as needed. As illustrated in Figure 5.3, [I, J, K] are the [column, row,
layer] indexes of the cell containing the starting location; [u, v, w] are the local
coordinates (ranging from 0 to 1) of the starting location within the cell. The
origin of [I, J, K] is the highest northwest corner of the model and the origin of
[u, v, w] is the lowest northwest corner of a cell. r is the retardation factor. z and
c are not used by Seer3D.



5.3 File Formats 85

Figure 5.3. Coordinate systems used by Format 3.

• Format 4: This format is the same as the Particle Starting Location file format used
by MODPATH (Pollock, [16]).
– I, J, K, u, v, w, ICODE, JCODE, KCODE, TRELEASE. A line contains the

data for a starting location. Repeat as often as needed. As illustrated in Figure 5.4,
[I, J, K] are the [column, row, layer] indexes of the cell containing the starting
location; [u, v, w] are the local coordinates (ranging from 0 to 1) of the starting
location within the cell. The origin of [I, J, K] is the highest northwest corner
of the model and the origin of [u, v, w] is the lowest southwest corner of a cell.
ICODE, JCODE, KCODE, TRELEASE are not used nor supported by Seer3D,
but they must be supplied. You can use any four numbers for them.

Figure 5.4. Coordinate systems used by Format 4.
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